Operation and Maintenance Manual

MiTek® Inker

Wood Truss Component Marking System
Matthews 5100, 5400, and 8400

Copyright © 2002, 2005 MiTek®. All rights reserved.
Operation and Maintenance Manual

MiTek® Inker
Wood Truss Component Marking System

Reporting Errors and Recommending Improvements

To report errors or if you wish to recommend improvements, please complete the form at the back of this document and mail or fax the form to:

MiTek
301 Fountain Lakes Industrial Drive
St. Charles, MO 63301
Attn: Engineering Manager
Fax: (636) 328-9218

We appreciate your assistance in helping MiTek provide unsurpassed machinery and support.

Copyright

© 2002, 2005, 2006 MiTek. All rights reserved.
No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of the publisher. Printed in the United States of America.

Return Goods Policy

MiTek cannot accept return goods without prior authorization and are subject to a restocking charge. The Seller certifies the articles specified herein were produced in compliance with all provisions of the Fair Labor Standards Act of 1938, as amended, including Section 12 thereof.
Rev. 6/98

Trademark

The trademark was applied for and obtained in the United States and in select foreign countries. It may not be reproduced, used, or otherwise exploited without written authorization from MiTek.
# Table of Contents

**General Information** .................................................................................................................. 1

- Supplies and Repair Information ................................................................................................. 1
  - Companies to Use for Supplies and Repair Services .................................................................. 1
  - Technical Questions and Repairs .................................................................................................. 2
  - Preventive Maintenance Contract ............................................................................................... 2
  - Consumable Supplies .................................................................................................................... 3

- Purpose ........................................................................................................................................... 4

- Identifying Your Inker Assembly .................................................................................................... 4

- Overview of Components ................................................................................................................ 5

**Installation** ..................................................................................................................................... 6

- Preparing for the Installation .......................................................................................................... 6
  - Hardware Requirements ................................................................................................................ 6
  - Drawings to Use .............................................................................................................................. 6
  - Required Tools .............................................................................................................................. 6
  - Understanding Your Saw ............................................................................................................... 6

- Installing the Components on a New Saw ....................................................................................... 7
  - Installing the New Parts ............................................................................................................... 7
  - Installing the Inker Table Components ....................................................................................... 9

- Installing the Components for a Field Installation ........................................................................ 10
  - Installing the New Parts .............................................................................................................. 10
  - Installing the Inker Table Components ....................................................................................... 13

- Wiring the Components .................................................................................................................. 14
  - PC Enclosure Wiring .................................................................................................................... 14
  - Touch Screen Enclosure Wiring ................................................................................................... 17

- Installing the Software .................................................................................................................. 21
  - Removing Unnecessary Software ............................................................................................... 21
  - Activating the Inker Software .................................................................................................... 21

- Inker Settings .................................................................................................................................. 22
  - Adjusting Photoeye Sensitivity ..................................................................................................... 22
  - Setting the Communication Parameters ..................................................................................... 22

- Installation Checklist ..................................................................................................................... 23

**Operation** ..................................................................................................................................... 24

- Startup .......................................................................................................................................... 24

- Operating the Software .................................................................................................................. 24
  - Setup the Printer Type ................................................................................................................ 24
  - Setup the Comm Port and Communications Protocol ................................................................. 25
  - Setup the Printed Message ........................................................................................................... 27
  - The Main Screen .......................................................................................................................... 30

- During Operation ............................................................................................................................. 32
  - How the Ink Works ....................................................................................................................... 32
  - How the Print Head Arm Works .................................................................................................. 32

**Maintenance** .................................................................................................................................. 33
FINDING MAINTENANCE AND TROUBLESHOOTING INFORMATION ................................................................. 33
PREVENTIVE MAINTENANCE OVERVIEW ..................................................................................................... 33
  Daily Preventive Maintenance ....................................................................................................................... 33
  Periodic Preventive Maintenance ............................................................................................................... 33
HOW TO MAINTAIN YOUR INKER ................................................................................................................. 34
  Cleaning Print Head Faceplate ..................................................................................................................... 34
  Flushing Print Head ................................................................................................................................... 35
  Adjusting Air Pressure ................................................................................................................................. 35
  Replacing Ink Filters and Cleaner Filters ................................................................................................. 36
  Replacing Reservoirs .................................................................................................................................. 36
  Adjusting Location of Image on the Board ................................................................................................. 37
  Encoders ...................................................................................................................................................... 37

Appendix A: Troubleshooting .......................................................................................................................... 38
  SUMMARY OF TROUBLESHOOTING PROCESS ............................................................................................ 38
  SPECIFIC TROUBLESHOOTING ISSUES ....................................................................................................... 39
    Inker Not Printing ....................................................................................................................................... 39
    Message Not Updating ................................................................................................................................. 39
    Ink Not Hitting the Board ............................................................................................................................. 39
    Message Not All on Board ............................................................................................................................ 39
    Message Not Legible ................................................................................................................................... 40
    Chain Timing Is Off or Boards Mis-Feeding Through the Conveyor ......................................................... 40

Appendix B: ASCII Codes ............................................................................................................................... 41
Appendix C: Inker Communication Port Errors .............................................................................................. 42
Appendix D: Inker Settings ............................................................................................................................... 43
Appendix E: Parts List ........................................................................................................................................ 44
Appendix F: Drawing List .................................................................................................................................. 46
Appendix G: Readers’ Comments .................................................................................................................... 47
Appendix H: Matthews 8400 Operator Manual ............................................................................................... 49
Inker Agreement

In exchange for purchasing the MiTek® Inker, part number 78830-501, from MiTek, the user (customer) of the Inker can expect the following from MiTek:

1. MiTek agrees to install the aforementioned Inker during the installation of a new Cyber® A/T saw purchased at the same time as the Inker. If purchased separately, the Inker will be installed at a mutually scheduled time between MiTek and the user.
2. MiTek will provide training and startup assistance during the installation of the Inker.
3. After installation is complete, MiTek will provide on-site assistance for software or saw related issues only. Mechanical repairs to the Inker are the responsibility of Matthews and the user (customer).

In exchange for purchasing the MiTek Inker from MiTek, the user (customer) of the Inker can expect the following from Matthews, the manufacturer of the Inker:

1. Matthews will perform all warranty services of the MiTek Inker.
2. Matthews will supply all of the perishable supplies when they are purchased by the user. MiTek will not be providing perishable supplies.

In exchange for purchasing the MiTek Inker from MiTek, the user (customer) of the Inker acknowledges the following:

1. The user understands the capabilities of the MiTek Inker, including its limitations, as integrated with the saw. The user agrees that MiTek is only responsible for providing the stated capabilities of the MiTek Inker during the installation and after the MiTek Inker is operational. Additional capabilities are not available without prior agreement with MiTek, which may delay shipment and installation of the MiTek Inker.
2. The user agrees to have the site ready for installation of the MiTek Inker at the scheduled time of installation. This includes, but is not limited to, building completion, available access to the building, power on site for the saw and MiTek Inker, power in the correct location for the saw and MiTek Inker, air to the saw, and access to required tools.
3. The user agrees to have adequate materials and samples for testing the operation of the Inker and training on operation during the installation. The user should have actual cutting information that can be downloaded from the saw to the MiTek Inker.
4. The user agrees to purchase all consumable supplies such as ink or solvent at least three (3) weeks prior to the installation of the Inker, as they will not be included with the Inker. The table below lists the necessary consumables that must be available for use during installation.
**Consumable Supplies and Vendors List**

<table>
<thead>
<tr>
<th>Description of Supplies</th>
<th>Unit of Issue</th>
<th>Quantity</th>
<th>To Order From the Manufacturer: Matthews</th>
<th>To Order From the Distributor: Primary Marking Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAM 7500, cleaner</td>
<td>Case</td>
<td>6, 1-liter bottles</td>
<td>I029990046</td>
<td>091410299-900-46CS</td>
</tr>
<tr>
<td>DPI 411, black ink</td>
<td>Case</td>
<td>12, 1-liter bottles</td>
<td>I041090288</td>
<td>091410410-902-88CS</td>
</tr>
</tbody>
</table>

*On average, the Inker uses 1 liter of ink every 2 weeks. This is based on a 5-day workweek, 1 shift per day.*

If ordering consumable supplies from Matthews, send a purchase order and a completed credit application to become a Matthew’s customer. Failure to supply the purchase order will delay the shipment of the supplies. The credit application is located in the user’s Operation and Maintenance Manual. If you do not have a manual, contact your Matthews representative to obtain a credit application.

5. The user agrees to follow the maintenance procedures recommended by MiTek and Matthews. This may involve hourly, daily, weekly, monthly, and annual maintenance on the MiTek Inker. Ink for the MiTek Inker is required to be stored and used at a temperature of at least 32ºF to prevent ice crystals from forming and clogging the Inker.

6. The user is responsible for establishing and maintaining a relationship with Matthews International Corporation by calling 1-877-652-0420 or visiting the company web site at www.matthewsmarking.com.

7. The user has received and read the MiTek Inker manual and understands its contents.

8. Failure to follow these items may delay the installation and start-up of the MiTek Inker. It may also result in extra charges from MiTek and Matthews, depending on the severity and nature of the discrepancy.

This agreement must be signed and returned to MiTek prior to the Inker being shipped to the user. Failure to sign this agreement will delay the shipment and installation of the MiTek Inker.
Mathews Credit Application

All Credit Applications Are Kept Confidential
Mathews International Corporation, Credit Department
2 Northshore Center Pittsburgh, PA 15212 Phone: 412-442-8255
Fax: 412-442-8291

Company_____________________________________________________
Name ______________________________________________________
Address _____________________________________________________
Phone________________________________________Fax____________

Names of Officers:
President_____________________________ □Corporation
Vice President _______________________ □Partnership
Treasurer ___________________________ □Sole Proprietorship

Please fill in the sections below and/or attach a financial statement.

Current Purchase Order Amount: _________________ Purchase Order No. ________

Please offer trade references that demonstrate credit limits equal to or in excess of the
current purchase order amount. A bank reference can be added as an additional credit
source.

Trade References:

Name __________________________ Phone # __________
Address ________________________ Fax # __________

Name __________________________ Phone # __________
Address ________________________ Fax # __________

Name __________________________ Phone # __________
Address ________________________ Fax # __________

Bank Reference:

Name ___________________________________________________________
Address _________________________________________________________
Phone # __________________________________ Account # _______________
Signature __________________________ Date _________________________
Title ________________________________

Attach applicable tax exemption certificate to credit application, if not previously sent
with purchase order. To expedite credit approval, please fax to: Matthews International
Corporation. Attn: Russell Bateman, Fax # 412-665-2594
General Information

Supplies and Repair Information

Companies to Use for Supplies and Repair Services

Contact the distributor or manufacturer for consumable supplies, replacement parts, and service. You may find lower prices and shorter delivery time when using the distributor. The contact information for both companies and MiTek Customer Service are listed below.

**Distributor and Service Provider**
Primary Marking Systems, Inc.
4330-W Rider Trail North
Bldg. D Dock 10
Earth City, MO 63045
Phone: 314-344-9178
Toll free phone: 888-261-9178
Fax: 314-344-9955
Hours: 8:00 a.m. to 5:00 p.m. CST
[www.primarymarking.com](http://www.primarymarking.com)
Distributor and Service Provider
Sales Representative: Tim McIntyre
Phone ext: 202, email: tmcintyre@primarymarking.com
Parts and Service Manager: Jim Stietz
Phone ext: 203, email: service@primarymarking.com

**Manufacturer**
Matthews International Corporation
6515 Penn Avenue
Pittsburgh, PA 15206
412-665-2500
877-652-0420
[www.matthewsmarking.com](http://www.matthewsmarking.com)

MiTek Customer Service
phone: 800-523-3380

**Inker Identification Information**
JET•A•MARK® DOD•5100, DOD•5400, or DOD•8400
Technical Questions and Repairs
For technical questions or repairs, call the Service Manager at Primary Marking Systems, or you may call Matthews International Corporation directly. Appendix E lists the replacement part numbers for the Inker.

Preventive Maintenance Contract
To purchase a Preventive Maintenance Contract, contact Primary Marking Systems.
Consumable Supplies

To order consumable supplies, contact Primary Marking Systems, Inc. or Matthews directly. Their contact information is listed on page 1. MiTek does not sell ink and cleaner.

Refer to the Consumable Supply List below for the part numbers. Allow a minimum of one (1) week to receive supplies.

<table>
<thead>
<tr>
<th>Description of Supplies</th>
<th>Unit of Issue</th>
<th>Quantity</th>
<th>Matthews Part #</th>
<th>Primary Marking System’s Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAM 7500, cleaner DPI 411, black ink</td>
<td>Case</td>
<td>6, 1-liter bottles</td>
<td>I029990046</td>
<td>0914I0299-900-46CS</td>
</tr>
<tr>
<td></td>
<td>Case</td>
<td>12, 1-liter bottles</td>
<td>I041090288</td>
<td>0914I0410-902-88CS</td>
</tr>
</tbody>
</table>

*On average, the Inker uses 1 liter of ink every 2 weeks. This is based on a 5-day workweek, 1 shift per day.
Purpose

The purpose of the Inker is to print specifications of your choice on each cut board as it exits the saw.

Identifying Your Inker Assembly

<table>
<thead>
<tr>
<th>Mechanical Assembly</th>
<th>Factory Installation</th>
<th>Field Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inker assembly with conveyor and stand*</td>
<td>78830-501</td>
<td>78830-502</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Electrical Assembly</th>
<th>Field Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>For touch screen computer, 230 VAC</td>
<td>90458KIT</td>
</tr>
<tr>
<td>For computer in PC enclosure</td>
<td>90483KIT-501</td>
</tr>
<tr>
<td>Field Installation</td>
<td>90483KIT-601</td>
</tr>
</tbody>
</table>

* The mechanical assembly WITHOUT the inker printer kit and stand is 78830-601 and 78830-602
Overview of Components

Figure 1: Components on Inker Stand

Figure 2: Print Head Arm Assembly

- Slide for horizontal adjustment
- Adjustment Bracket for vertical adjustment
- Swingarm
- Photo Trigger Prox Switch
- Print Head
- Lumber Guide
Installation

Preparing for the Installation

Hardware Requirements
The Inker requires a 15-amp, 120-volt power source to operate.

Drawings to Use
The drawings in the back of this manual will assist during installation of the Inker. A complete list and description of each drawing can be found in Appendix F.

- If the saw’s computer is inside a PC enclosure, refer to Drawing 90503 for computer hardware and wiring questions.
- If the saw’s computer is inside the touch screen enclosure, refer to Drawing 90504 for computer hardware and wiring questions.
- Refer to Drawing 90500 in your saw’s Operation and Maintenance Manual for questions regarding the electrical system for the complete saw.

Required Tools
7/8” step drill
1/2” conduit knockout
1/8” slotted screwdriver (terminal block screwdriver)
#2 Phillips screwdriver
2.5-mm Allen wrench
Wire stripper

Understanding Your Saw
If installing the Inker on a newly-manufactured saw, the saw’s computer is located in a separate PC enclosure, and the drawings in this manual accurately reflect this. If installing the Inker on a saw that was manufactured prior to May 2005 and still has the touch screen computer located inside the touch screen enclosure, your electrical system will vary from the drawings in this manual.
Installing the Components on a New Saw

*If installing the inker on a previously installed saw, proceed to the next section.*

Installing the New Parts

1. Install the two (2) new outfeed arms.
   a. If there are previous outfeed arms on the saw, remove them.
   b. Bolt the two (2) new outfeed arms to the saw frame. An outfeed arm is shown in the photo.

2. Install the counter limit switch on the outfeed arm closest to the carriage end. The counter limit switch is labeled in the photo.
3. Bolt the print head arm assembly to the welded plate. The plate is labeled in the photo below.

4. Attach the inker print head to the frame using the print head mount shown in the photo.

5. Attach the photo trigger prox switch to the print head arm assembly as shown in the photo below.
Installing the Inker Table Components

6. Place the Inker table and secure it to the floor with concrete anchors if desired. It is generally placed at the stationary end and outfeed corner of the saw.

7. Set the control box, air compressor, and reservoirs on the inker table as shown in the photo.

8. Connect the ink reservoir and cleaning solution reservoir to the print head using the extensions provided.
   - The print head has one (1) extra hose extending from it that will not be used.
   - Use the black disconnect for the ink reservoir.
   - Use the yellow disconnect for the cleaner reservoir.

9. Connect the Y-shaped hose extending from the reservoirs to the air compressor.

10. Plug the compressor into a standard 110-volt outlet.

11. Connect each cable from the control box as shown in the diagram. The connections required inside the control box are labeled inside the control box.
Installing the Components for a Field Installation

Installing the New Parts

1. Completely pull out the outfeed drive shaft to add the encoder and sprocket.

2. Drill and tap all holes in the infeed drive mounting plate on the saw as diagrammed in Drawing 78848, Rework Detail B.

3. Install sprockets and belt.

4. Install the encoder bracket and encoder.

5. Install the encoder guard bracket and encoder guard.

6. Install the two (2) new outfeed arms.
   a. If there are previous outfeed arms on the saw, remove them.
   b. Bolt the outfeed arms to the frame using the three (3) existing holes.
   c. Drill and tap two (2) additional holes in the frame.
      i. Using the two (2) additional holes already located in the arm as a template, drill and tap two (2) holes in the saw frame.
      ii. Secure the arm to the frame using bolts (cap screws) through those two (2) holes.
7. Install the counter limit switch on the outfeed arm closest to the carriage end. The counter limit switch is labeled in the previous photo. If this is a field install, the limit switch was previously located on the infeed/outfeed conveyor on the carriage end. Additional cable must be added with a junction box mounted on the inker arm.

8. Attach the print head arm assembly. It is shown in the photo below.
   a. Weld the plate to the guarding using a 1/4-in. fillet stitch weld on three (3) sides. Refer to Drawing 78848-501 for location and weld details.
   b. Bolt the print head arm assembly to the welded plate.

9. Attach the inker print head to the frame using the print head mount shown in the photo.

10. Attach the photo trigger prox switch to the print head arm assembly as shown in the photo.
Installing the Inker Table Components

1. Place the Inker table and secure it to the floor with concrete anchors if desired. It is generally placed at the stationary end and outfeed corner of the saw.

2. Set the control box, air compressor, and reservoirs on the inker table as shown in the photo.

3. Connect the ink reservoir and cleaning solution reservoir to the print head using the extensions provided.
   - The print head will have one (1) extra hose extending from it that will not be used.
   - Use the black disconnect for the ink reservoir.
   - Use the yellow disconnect for the cleaner reservoir.

4. Connect the Y-shaped hose extending from the reservoirs to the air compressor.

5. Plug the compressor into a standard 110-volt outlet.

6. Connect each cable from the control box as shown in the diagram. The connections required inside the control box are labeled inside the control box.

A key is required to open the control box cover. Keep this key in a safe place.
Wiring the Components

PC Enclosure Wiring

This portion of the manual is for customers with the computer inside a PC enclosure. If you have a touch screen computer inside a touch screen enclosure, see the next section.

Figure 3: Wiring After Inker is Installed on a Saw With a PC Enclosure

** May need to add these terminal blocks and/or use a jumper bar.
1. Refer to Figure 3 while connecting the Inker to a computer in a PC enclosure.

2. Shut down and lockout/tagout power to the saw.

3. Have a qualified electrician install an external 115 VAC standard double outlet to power the Inker head and the Inker’s pump.

   The outlet must be on a electrical circuit separate from the saw. Locate the outlet as close to the Inker stand as possible without entering an electrical enclosure on the saw.

4. If this is a field install, drill a hole in the bottom of the stationary-end enclosure for the 15-ft long #16-4 cable:
   a. Use rags or paper to protect the electrical components inside the stationary-end enclosure from metal chips and filings.
   b. Referring to the drawing for your machine and using a 7/8” step drill or a 1/2” conduit knockout, cut a hole in the bottom of the stationary-end enclosure.
   c. Install the ½-in. straight cable connector with locknut in the bottom of the stationary-end enclosure.

5. Use the supplied grommets to replaced the blank grommets in the back of the PC enclosure. Refer to Figure 3 for the intended location of each grommet.

6. Connect the supplied #16-4 cable between the stationary-end enclosure and PC by completing these steps:
   a. Connect the #16-4 cable wiring inside the stationary-end enclosure as described here. (If this is a new saw, these connections are already made and the cable is rolled up inside the stationary enclosure.)
      - the black wire to terminal Q-071
      - the white wire to terminal X2
      - the green ground wire to the ground block
   b. Route the #16-4 cable from the inside of the stationary-end enclosure through the cable fitting in the bottom of the stationary-end enclosure.
   c. Run the #16-4 cable through the wiring opening in the pan and through the PC enclosure’s grommet labeled “Inker Data” in Figure 3.
   d. Connect the #16-4 cable wiring inside the PC enclosure as follows:
      - the black wire to terminal Q-071
      - the white wire to terminal X2
      - the green ground wire to the ground block

7. For a field install, install a supplied relay module on the DIN rail in the PC enclosure.

8. Connect the serial communication cable by performing these steps:
   a. Connect one end of the serial communication cable to the Inker.
   b. Thread the serial communication cable through the end frame tube located under the stationary-end enclosure, and through the PC enclosure’s grommet labeled “Inker Control” in Figure 3.
   c. Plug the serial communication cable into Comm Port 3 or 4 on the PC.
9. Connect the extra wires from the serial communication cable to the appropriate terminal blocks, and then to the control relay (CR3).
   a. Take wire SC4 to the terminal block SC4, then terminate wire SC4 at terminal E on the relay module, CR3.
   b. Take wire SC1 to the terminal block SC1, then terminate wire SC1 at terminal B on the relay module CR3.

10. Connect a white wire between terminal G on the relay module and an open terminal block labeled X2 on the terminal strip in the PC enclosure.

11. Connect a red wire labeled Q071 from terminal H on the relay module to the terminal block labeled Q071 in the PC enclosure.

12. Plug the control box and compressor into a power source.

13. Return power to the saw.

14. Verify that your Cimplicity® program on the saw is at least version 12.0 for a Cyber A/T saw or version 5.2 for a Cyber saw. If not, contact Machinery Division Customer Service to upgrade your Cimplicity software.

   **NOTE**

   Upon completion of the wiring steps above, complete the procedure for installing software on page 21 of this manual.
Touch Screen Enclosure Wiring

This portion of the manual is for customers with the computer inside a touch screen enclosure. If you have a computer inside a PC enclosure, see the previous section.

Figure 4: Wiring After Inker is Installed on a Saw With a Touch Screen Computer

* May need 25-to-9 pin adaptor for some saws. The adaptor is not supplied.

** May need to use a jumper bar if there are no free terminal screws in terminal block X2. The jumper bar is supplied.
1. Refer to Figure 4 while connecting the Inker to a touch screen computer in a touch screen enclosure.

2. Shut down and lockout/tagout power to the saw.

3. Inside the touch screen enclosure, mount the included relay module and three (3) terminal blocks on the DIN rail by performing these steps:
   a. Determine if all 4 pieces will fit on the existing DIN rail inside the touch screen enclosure.
      i. If so, loosen the lower end stop and slide it away.
      ii. If not, mount a new DIN rail inside the touch screen enclosure. It is included.
   b. Label the relay module and terminal blocks as follows, using ??:

<table>
<thead>
<tr>
<th>Component</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relay Module</td>
<td>CR3</td>
</tr>
<tr>
<td>Terminal Blocks</td>
<td>SC1</td>
</tr>
<tr>
<td></td>
<td>SC4</td>
</tr>
<tr>
<td></td>
<td>I-158</td>
</tr>
</tbody>
</table>

c. Install the relay module and terminal blocks on the DIN rail and install the end stops.

4. Route the serial cable from the Inker through the cable track, carriage-end trough, and swing arm assembly to the touch screen enclosure.

5. Connect the serial communication cable by performing these steps:
   a. Connect one end of the serial communication cable to the Inker.
   b. Thread the serial communication cable through the cable track, carriage-end trough, and swing arm assembly to the touch screen enclosure.
   c. Plug the serial communication cable into Comm Port 1 or 2. An adaptor may be necessary to go from 25 pins to 9 pins, and it is included.

6. Connect the extra wires from the serial communication cable to the appropriate terminal blocks, and then to the control relay (CR3).
   a. Take wire SC4 to the terminal block SC4, then terminate wire SC4 at terminal E on the relay module, CR3.
   b. Take wire SC1 to the terminal block SC1, then terminate wire SC1 at terminal B on the relay module CR3.
7. Connect a white wire between the open terminal screw labeled (X2) on the terminal strip in the touch screen enclosure and terminal G on relay module CR3 in the touch screen enclosure. If there are no open terminal screws, add a terminal block and use a supplied jumper bar.

8. Connect a red wire labeled I158 from terminal H on relay module CR3 to the terminal block labeled I158.

9. Connect a red wire labeled I158 from the added terminal block located in the touch screen enclosure, to the existing terminal block labeled I158 located in the carriage-end enclosure. Route the wire using the same path as the existing wiring through the trough, conduit, and swing arm assembly.

NOTE
Complete all the wiring connections before returning power to the saw.
10. Plug the Matthews Inker control box and compressor into a power source.

11. Return power to the saw.

12. Verify that your Cimplicity® program on the saw is at least version 12.0 for a Cyber A/T saw or version 5.2 for a Cyber saw. If not, contact Machinery Division Customer Service to upgrade your Cimplicity software.
Installing the Software

Removing Unnecessary Software

For Cyber saws Only (NOT Cyber A/T Saws)

If you have an Ann Arbor touch screen with UPS software installed on a Cyber saw, remove the UPS software and disconnect the UPS serial cable from the computer. The software is not needed. This paragraph does NOT apply to Cyber A/T saws.

Activating the Inker Software

The Inker software is embedded within your existing Project software, but as a default, it is turned off. To operate your Inker, you must first activate the Inker software using the following procedure.

1. When the logo screen appears after logging into Cimplicity, touch the screen to advance to the Main Menu.
2. Turn on the calibration key and press the “Defaults” button.
3. Press the “Speeds” button.
4. Press the “Advanced” button.
5. Ignore the prompt asking for a password. Press “OK”.
6. Press the “Member Labeling” button.
7. Activate the Inker software by pressing the “ON” button in the “Inker” box.
8. Press the “Main Menu” button and wait approximately 1 minute.
9. Press the “Automatic” button.
10. Press the “Inker” button at the bottom of the screen. This will display the MiTek Inker program.
Inker Settings

Adjusting Photoeye Sensitivity

Adjust the photo eye sensitivity by unscrewing the top cover which reveals the adjustment screw. Turn the screw counterclockwise to reduce the sensitivity and clockwise to increase it. Now place a piece of lumber under the photo eye, but on the inker arms to make the adjustment. The red LED will be lit indicating the lumber is present. Turn the screw counterclockwise until the light starts to blink, and continue until it goes out completely. Turn it back clockwise a couple of turns and the light should come back on. Now remove the lumber and move the infeed until the inker arm is directly under the photo eye. Make some adjustments to prevent the photo eye from seeing the inker arm but it does sense the lumber when passing underneath.

Setting the Communication Parameters

NOTE

It is not necessary to make any changes to the communications settings at this point. Your software is pre-configured to use Comm Port 1.

Refer to the settings listed in Appendix D during the installation and startup process. The Matthews manual and the adjustments in the Maintenance section will assist you in setting these specifications.
Installation Checklist

☐ Chain Timing—Make sure the outfeed chains are timed to advance lumber evenly under the print head. Board should fall, settle, and then the lugs should hit the lumber with no instances of the lumber landing on the lugs. Make sure the large infeed chain flights are also timed with each other in the cutting area.

☐ Verify the print head ski is not touching the lumber. It should be positioned just above (approx. 1/8 in.). Ski should be level, not tilted up or down. It may require shims to level it. The print head should also be 1/8 in. above the ski for protection.

☐ Make sure the print head ski is positioned so the inker arm will not be underneath it on most cuts. This could affect the trigger photo eye from sensing the lumber properly.

☐ Adjust the photo eye sensitivity (details given in this chapter).

☐ Verify that the counter (count) limit switch power cord is long enough that when the infeed is extended completely out that some slack remains. Failure to do so can cause the cable to pull out and short.

☐ Check quality of the print. Verify 8 characters can fit on a 2x4 per line. Also the print should be centered on the 2x4 to allow a small margin on the left side. If the lines have a slight tilt from line to line then adjust the height setting in the printer from 80 percent to a new value (78 or 82). This will affect the tilt of the lines. Character height is not as important as tilt and legibility.

☐ Verify PLC software version is at least v12.3 for a Cyber A/T saw with a PC. For an Cyber saw with a PC, work with Customer Service and Engineering to obtain the correct PLC software. If the version is inadequate, the output Q-071 will not be fired and the relay will not index the messages properly during the cutting.

☐ Verify relay wiring matches the drawing.

☐ Clean up cabling for the Inker. All cables should be neatly run and tied up where applicable. Use wire ties with care not to pinch the ink and cleaner hoses. Excess cables can be coiled neatly and pushed into the fork lift tubes or behind the Inker stand.

Tell the customer the following:

☐ Place something on the floor to absorb the excess ink sprayed when flushing the print head.

☐ The Inker unit must be turned on first when starting the equipment in the morning. This helps establish the comm. link between PC and printer.

☐ The Inker will continue to print the last message sent in automatic even when the operator is cutting in Semiautomatic Mode. Therefore, the board will be mislabeled when printing in Semiautomatic Mode unless they turn off the printer in the default menu.
Operation

Startup

Turn the inker unit on first when starting the equipment in the morning. This helps establish the communication link between the PC and the printer.

Operating the Software

NOTE: The Inker will continue to print the last message sent in Automatic Mode, even when the operator is cutting in Semiautomatic Mode. Therefore, the board will be mislabeled when printing in Semiautomatic Mode unless you turn off the printer off using the Defaults Menu.

Setup the Printer Type

1. Choose “Setup”, then “Printer” to select the type of Inker installed.
2. From the dialogue box shown below, select the Matthews Inker that is installed on your machine. Keep the Auto-Flush option checked to help maintain the print quality.

**Setup the Comm Port and Communications Protocol**

Choose “Setup”, then “Port” to change the Comm Port and communications settings.
Communications Settings

These settings have been set at MiTek. For more information, see the Matthews MattCom manual.

**NOTE**

These settings are set at MiTek to match the settings programmed on the Matthews Inker. The Comm Port setting should be set to one (1) on a Cyber saw and two (2) on a Cyber A/T saw.

If the Comm Port Setup must be changed, select the correct settings for the Communications Port, Baud Rate, Data Bits, Stop Bits, and Parity fields from the drop down menu as shown in the figure below.

*Flow Control*

Flow Control settings should **NOT** be changed. Hardware Flow Control must be enabled.
Setup the Printed Message

To change the message format settings, choose “File”, then “Setup Display”.

Format Strings

The format strings determine what information is printed on the lumber. The Available Fields window lists all the choices for data that the Inker can automatically print. The Inker can print up to four (4) lines of text on each board, with eight (8) characters per line. Indicate which fields of data you want to print by selecting or typing them in the “Format” boxes.

If using a mouse, you can place the cursor in any of the four (4) “Format” boxes, and then double-click on the desired field in the “Available Fields” box. To place two (2) fields on one (1) line, press the space bar, then select the second available field.

If using a touch screen, touch the beginning of any of the four (4) “Format” boxes with your finger and type the name of the available field you want surrounded by < >. To place two (2) fields on one (1) line, press the space bar and type the second available field name in the same manner.

Examples:

<JOB>

<JOB> BATCH>
Available Fields

Count—This displays the number of pieces that have been cut.
QTY—This is the quantity for the current piece.
Job—The job name.
Batch—The EZY/CYB file name.
Truss—The truss name.
Member—The member ID.
Length—The length setting for the saw. This is also the overall length.
StkLen—The stock length, as determined by CyberSort™.
Size1—The number two (2) in 2x4.
Size2—The number four (4) in 2x4.
SPR2—This field holds the crowning value, 0= No Crowning, 1= Crown Up and 2= Crown Down.
SPR3—Currently not used.
SPR4—Currently not used.
GRADE—The lumber grade for the current piece.
EXTRA—Used only in Australia.

Constant text can also be placed in the format string. The value for these characters can be ASCII codes in the range of 1 to 125, excluding ASCII codes 3, 8, 22, and 34, which are Ctrl -c (copy), Backspace, Ctrl-v (paste), and Ctrl -x (cut) respectively. Type all character codes directly from the keyboard. Appendix B illustrates how to enter ASCII codes.

Trim First 2 Characters of Job Name

Enabling the “Trim First 2 Characters of Job Name” feature removes the first two (2) characters of the job name for display purposes.
Print Logo

Enabling the Print Logo feature allows the operator to print a bitmap image or logo that has been created and stored in the Matthews Inker. The logo will be positioned in the bottom left corner of the printed message. Using the “Offset” option, shift the text of the message to the right to allow space for the logo to print. Each line of text can be offset as required.

If the logo is eight (8) dots tall or smaller, only the fourth line will require offsetting.

If the logo is between 9 and 16 dots tall, the third and fourth lines of text will require offsetting.

If the logo is between 17 and 24 dots tall, the second, third, and fourth lines will require offsetting.

If the logo is taller than 24 dots, all four lines of text will require offsetting.

NOTE

Printing a logo reduces the number of characters printed on the indented lines by one character for every five (5) dots of logo width.

The logo name field provides the program with the name of the logo at the Inker to include in the message.

See the Matthews Operations manual for instructions on creating and saving bitmap images.

Offset

The Offset option only applies if the Print Logo option is enabled. Each line will be shifted to the right by the number of dot columns in this field to allow enough space for the graphic. The values should be one (1) or two (2) dot columns higher than the width of the graphic. See the Print Logo option for more information.

Font

Each line of text can be set to print using either the 7x5 font or the 5x5 font. Changing the font does not change the number of characters per line that can be printed. Only the printed height of the text will change.
The Main Screen

**Current Display or Current Message**

The Current Display or Current Message field shows the fields that are currently being printed.

**Current Queue**

The Current Queue box displays the list of pieces currently being cut. The format is Quantity: Member: Truss. The current piece is highlighted and displayed as it is being cut. Once the last member has been cut, the operator can scroll through the data for all the pieces in the current setup.

**Next Queue**

The Next Queue box displays the list of pieces for the next setup.
**Last Message from Printer**

The Last Message from Printer box displays the messages sent to and from the Inker. Some of the messages that may be displayed are as follows:

- **DOWNLOAD COMPLETE**–The current print message was successfully sent to the Inker
- **OK**–The last command was received and processed successfully
- **FLUSH COMPLETED**–The flushing procedure has been completed

**Clear**

The Clear button clears the message displayed and both message queues.

**Stage**

When a new member is loaded either by the operator or during automatic operation of the saw, the Stage button retrieves the data for the next setup.

**Start**

When the Start button is pressed on the automatic screen of the saw, the next queue is sent to the Current Queue and the message for the first piece is sent to the display.

**Minimize**

The Minimize button hides the MiTek Inker program on the screen.

**End**

The End button closes the MiTek Inker program. The Inker will continue to print the last message received.

**Last Command**

The Last Command button provides information to MiTek Service Personnel.

**Connection State**

The Connection State provides information to MiTek Service Personnel.
During Operation

How the Ink Works
The ink and cleaner (solvent) mix inside the print head with a ratio of 3 parts ink to 1 part cleaner (solvent).

How the Print Head Arm Works
The print head arm assembly is designed with two (2) sets of hinges to avoid jams and help keep the board oriented properly. Occasionally, a board will turn upright as it is exiting the saw. The hinges on the ski (lumber guide) will usually cause the board to fall back down so the correct surface is facing up. If it doesn’t reorient the board, the hinges on the arm allows the entire arm to raise up so a jam should not occur.
Maintenance

Finding Maintenance and Troubleshooting Information

The Maintenance section provides instructions for the most common maintenance and adjustments needed to keep your Inker in good working condition. For more technical and troubleshooting information, refer to the Matthews manuals that came with your Inker. It is also located at the back of this manual in Appendix H.

This MiTek manual covers most models of the Matthews Inker that MiTek has sold, but the Matthews manual is only for the most recent model. If you require a Matthews manual for an Inker other than the model indicated on the Matthews manual, contact your Matthews representative.

CAUTION
Using any functions of the Inker except those spelled out in the MiTek or Matthews manual may render your system inoperable. Do not attempt any undocumented maintenance unless supervised by MiTek, Matthews, or service provider personnel.

Preventive Maintenance Overview

Daily Preventive Maintenance
Clean components are vital to ensuring high-quality printing. Although this is difficult in a dusty environment, there is some preventive maintenance that will help.

- Blow off or wipe off the control box, compressor, and inker stand daily.
- Blow off or wipe off the inker head arm assembly daily, but NEVER blow or wipe directly on the faceplate of the inker head.
- Check all connections between cables and tubing.
- Check the quality and location of the printed image.
- Check the inker and cleaner levels in the reservoirs

Periodic Preventive Maintenance
- Clean the faceplate as needed, per the instructions in this section.
- Replace the inker filter
- Replace the cleaner filter
How to Maintain Your Inker

Cleaning Print Head Faceplate

The print head faceplate should be cleaned periodically. When dried ink and debris begins to build up on the faceplate, or you notice a degradation of print quality, follow these instructions to clean the faceplate.

**CAUTION**

Never use a rag or scraper to wipe off the faceplate! It will force dried ink and debris into the nozzles and may cause permanent damage.

* Alternative methods: Instead of using a spray bottle, you may use a squeeze bottle or dip the brush directly in cleaner.
Flushing Print Head

The print head should be internally flushed with cleaner periodically. Print head flushing occurs automatically on the 8400 model between each job and when the inker is first turned on each day, but you may need to initiate an additional flushing in the following cases:

- Print quality degrades
- The ink or cleaner reservoir is completely emptied
- After cleaning the faceplate

To Flush From the Saw’s Touch Screen

Place an absorbent material on the floor to protect the floor from ink spray.

In Automatic Mode, choose the inker icon at the bottom of the saw’s touch screen.

The Main Menu appears. Choose FLUSH PRINTER.

To Manually Flush:

Place an absorbent material on the floor to protect the floor from ink spray.

On the Inker’s control box, press  and  (or A and B) at the same time to switch between ink  and cleaner  .

Wait until the indicator light shows the change has been accepted.

Press  (or B) for at least 1 second.

Adjusting Air Pressure

The air compressor comes with the inker system and sits next to the control box on the inker stand. The recommended amount of air pressure for good print quality is 4-7 psi.

If the ink is spattering and spreading out, you may need to reduce the air pressure slightly. If the ink is blotting together or filling in, you may need to increase it. To adjust the pressure:

1. Pull out on the pressure adjustment knob to unlock it.
2. Turn the knob clockwise to increase pressure or counterclockwise to decrease pressure.
3. Push the knob in to lock it in place.
Replacing Ink Filters and Cleaner Filters

The inker and cleaner reservoirs have a filter under the cap that should be replaced periodically. To remove the old filter, simply pull it out and replace it with a new filter. The parts numbers are listed in Appendix E.

- Replace the ink filter every month. The minimum frequency is every 55 gallons of ink used, but due to the high levels of dust in your environment, you will see better results if you replace it monthly.

- The cleaner filter should be replaced every 2-3 months.

Replacing Reservoirs

For best results, replace the ink and cleaner reservoirs before they are completely empty. When the fluid level falls out of sight, replace the reservoir. If they run completely out of fluid, you must flush the ink head. See page 3 for consumable supplies part numbers.

The cap and stick assembly does not get replaced when you replace reservoirs, but in time, it will wear out. To purchase new cap and stick assemblies for the reservoir bottles, order the part from Matthews using the part number listed in Appendix E.

CAUTION

Turn off the compressor before attempting to loosen a reservoir lid!

Never use ink that is past its expiration date.

Discard old ink and reservoir bottles according to government specifications.

1. Turn off the compressor
2. Unscrew the reservoir lid and set aside on a surface that can catch any ink or cleaner that leaks out.
3. Screw the lid onto a new reservoir.
Adjusting Location of Image on the Board

The exact location that the image prints on the board depends on several specifications which are described here. The recommended settings for the specifications are listed in Appendix D.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tilt</td>
<td>Changes with the height; as it changes, the top left corner of the image will get closer to or further from the edge of the board; the print head is physically sitting at an angle best suited for the recommended tilt and height settings</td>
</tr>
<tr>
<td>Spacing</td>
<td>The horizontal spacing between letters</td>
</tr>
<tr>
<td>Distance</td>
<td>The distance the inker thinks the photo trigger is from the ink head nozzles. This determines when the Inker starts printing.</td>
</tr>
<tr>
<td>Height</td>
<td>Determines the angle the image prints at; as you change the height, the tilt automatically changes—100% height is 0 tilt which is the maximum size for that font</td>
</tr>
</tbody>
</table>

1. To change any of the parameters above, use the control box to go to Installation>Advanced.
2. Press ENTER.
3. Use the down arrow to make your selection.
4. Use the arrows or enter the exact number.

Encoders

An encoder controls when the print head begins printing. It is located behind a guard near the stationary-end outfeed arm. Instructions for replacing an encoder can be found in your saw’s Operation and Maintenance Manual.
Appendix A: Troubleshooting

Summary of Troubleshooting Process

Detailed troubleshooting suggestions can be found in the Matthews manual in Appendix H, but the following list of steps is a general procedure for checking the most common reasons why your Inker may not be printing.

1. Check to ensure there is ink in the printer.
2. Try flushing the ink and cleaner by using the touch screen to see if the computer and Inker are communicating.
3. If they are not communicating, check and fix the following:
   - Are all cables plugged in securely?
   - Is the baud rate setting correct?
4. If they are communicating, close the inker program on the saw, but do not change screens on the saw until required below.
5. Re-boot the printer.
6. On the saw, go to the Main Menu from any other screen. This will re-start the Inker software.
7. Look in the “Last Message From Printer” window in the inker software and see if the script was echoed back and ends with “Download complete”.
8. Now select a different piece on the saw.
9. Switch back to the Inker software.
10. Add the Count field
11. Press STAGE.
12. Press START.
13. Was “Download complete” or something to that effect echoed back in the last message from the printer window?
14. Open the print message on the printer.
15. Is the message correct?
16. Run a board through the saw to activate the Inker.
17. Does any ink come out of the print head?
18. Is the count updated in the touch screen inker software?

NOTE
Correct COM number shows in the control box window if Inker is working properly.
Specific Troubleshooting Issues

Inker Not Printing

1. Is printer communicating? Do you see COM 1 listed on the printer display? Are you able to flush the print head from the inker console on the touch screen? If not try turning off the inker and computer to reconnect the link between them. Verify COM cable is connected and not loose. Note: the inker unit must be started first and then the computer to enable the link.

2. Check the encoder belt. If it is cut or loose it will not print.

3. Check the pulleys are turning (Not slipping on the encoder shaft).

4. Check ink and cleaner bottles not empty. Is pump on? Is displayed message on printer readout changing with the setup?

Message Not Updating

1. Check relay wires coming out of the COM cable have not come loose at the relays and that the relay is firing consistently when the out counter is tripped during the cutting cycle.

2. Open inker console on touch screen and press pause/clear twice. Next minimize the console and go to the more menu. Select next setup. Exit out of the more menu and reopen the inker console. Press “Stage” and then “Start”. The message text should move to the current queue. Now run the next setup. Did the new message print?

3. PLC version must be v7 or higher to enable Q-071 on stand alone PC’s only. Out limit switch must be operable on the saw to fire the appropriate relay for updating the data stream being sent to the printer unit.

Ink Not Hitting the Board

1. Can you see ink spraying from print head? Flush the ink/cleaner if needed.

2. Is the photo trigger seeing something early (like the flight)? Adjust the beam strength adjusting screw to see only the lumber passing through the saw.

3. Is the photo trigger working? Is it positioned correctly?

4. Check all inker unit settings are correctly set per manual.

5. Check encoder belt and pulley’s not slipping.

Message Not All on Board

1. Adjust the photo trigger position slightly to fire sooner or later depending on message position.

2. Adjust the distance setting in the inker unit (Normally 2.5in). This changes the timing of the print head firing once the trigger is activated. Decreasing this number will effect message position to the left. Increasing this number will move it right.
3. Check chain timing and board movement under the photo trigger for smooth and even movement. Make sure the board is not moving through at an angle or landing on the chain lugs. Board should not be bouncing and timed to allow board time to settle and feed smoothly below the print head.

**Message Not Legible**

1. Flush the print head with ink and cleaner from the touch screen.
2. Check pump is on and pressure is set properly.
3. Is correct ink being used? Check bottle for proper type of ink.
4. Is the ink or cleaner bottle empty? Replace if needed.
5. Are all lines affected? If not clean affected print head jets. Make sure jet is not stuck open and firing constantly. This would be a Matthews issue if they are.
6. Check all cable connections to the printer unit are tight.

**Chain Timing Is Off or Boards Mis-Feeding Through the Conveyor**

1. Adjust chain timing by removing the connecting chain between the saw’s infeed and inker arm chains. Advance or retard the inker arm chains as needed to allow a board to fall and settle to advance under the print head. Reconnect the chains and check operation by cutting normally. This is trial and error and will likely take a few attempts to accomplish. Repeat adjustments as needed to find proper timing and alignment.
2. Adjust spring stops to stops if needed to completely stop the board and then release the board when the flights on the inker arm chains force the lumber through below the print head.
## Appendix B: ASCII Codes

**NOTE:**

The Ctrl Key is denoted by this symbol ^ in the following table.

<table>
<thead>
<tr>
<th>Code</th>
<th>Key</th>
<th>Code</th>
<th>Key</th>
<th>Code</th>
<th>Key</th>
<th>Code</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>^A</td>
<td>33</td>
<td>!</td>
<td>65</td>
<td>A</td>
<td>97</td>
<td>a</td>
</tr>
<tr>
<td>2</td>
<td>^B</td>
<td>34</td>
<td>&quot;</td>
<td>66</td>
<td>B</td>
<td>98</td>
<td>b</td>
</tr>
<tr>
<td>3</td>
<td>^C</td>
<td>35</td>
<td>#</td>
<td>67</td>
<td>C</td>
<td>99</td>
<td>c</td>
</tr>
<tr>
<td>4</td>
<td>^D</td>
<td>36</td>
<td>$</td>
<td>68</td>
<td>D</td>
<td>100</td>
<td>d</td>
</tr>
<tr>
<td>5</td>
<td>^E</td>
<td>37</td>
<td>%</td>
<td>69</td>
<td>E</td>
<td>101</td>
<td>e</td>
</tr>
<tr>
<td>6</td>
<td>^F</td>
<td>38</td>
<td>&amp;</td>
<td>70</td>
<td>F</td>
<td>102</td>
<td>f</td>
</tr>
<tr>
<td>7</td>
<td>^G</td>
<td>39</td>
<td>.</td>
<td>71</td>
<td>G</td>
<td>103</td>
<td>g</td>
</tr>
<tr>
<td>8</td>
<td>^H</td>
<td>40</td>
<td>(</td>
<td>72</td>
<td>H</td>
<td>104</td>
<td>h</td>
</tr>
<tr>
<td>9</td>
<td>^I</td>
<td>41</td>
<td>)</td>
<td>73</td>
<td>I</td>
<td>105</td>
<td>i</td>
</tr>
<tr>
<td>10</td>
<td>^J</td>
<td>42</td>
<td>*</td>
<td>74</td>
<td>J</td>
<td>106</td>
<td>j</td>
</tr>
<tr>
<td>11</td>
<td>^K</td>
<td>43</td>
<td>+</td>
<td>75</td>
<td>K</td>
<td>107</td>
<td>k</td>
</tr>
<tr>
<td>12</td>
<td>^L</td>
<td>44</td>
<td>,</td>
<td>76</td>
<td>L</td>
<td>108</td>
<td>l</td>
</tr>
<tr>
<td>13</td>
<td>^M</td>
<td>45</td>
<td>-</td>
<td>77</td>
<td>M</td>
<td>109</td>
<td>m</td>
</tr>
<tr>
<td>14</td>
<td>^N</td>
<td>46</td>
<td>.</td>
<td>78</td>
<td>N</td>
<td>110</td>
<td>n</td>
</tr>
<tr>
<td>15</td>
<td>^O</td>
<td>47</td>
<td>/</td>
<td>79</td>
<td>O</td>
<td>111</td>
<td>o</td>
</tr>
<tr>
<td>16</td>
<td>^P</td>
<td>48</td>
<td>0</td>
<td>80</td>
<td>P</td>
<td>112</td>
<td>p</td>
</tr>
<tr>
<td>17</td>
<td>^Q</td>
<td>49</td>
<td>1</td>
<td>81</td>
<td>Q</td>
<td>113</td>
<td>q</td>
</tr>
<tr>
<td>18</td>
<td>^R</td>
<td>50</td>
<td>2</td>
<td>82</td>
<td>R</td>
<td>114</td>
<td>r</td>
</tr>
<tr>
<td>19</td>
<td>^S</td>
<td>51</td>
<td>3</td>
<td>83</td>
<td>S</td>
<td>115</td>
<td>s</td>
</tr>
<tr>
<td>20</td>
<td>^T</td>
<td>52</td>
<td>4</td>
<td>84</td>
<td>T</td>
<td>116</td>
<td>t</td>
</tr>
<tr>
<td>21</td>
<td>^U</td>
<td>53</td>
<td>5</td>
<td>85</td>
<td>U</td>
<td>117</td>
<td>u</td>
</tr>
<tr>
<td>22</td>
<td>^V</td>
<td>54</td>
<td>6</td>
<td>86</td>
<td>V</td>
<td>118</td>
<td>v</td>
</tr>
<tr>
<td>23</td>
<td>^W</td>
<td>55</td>
<td>7</td>
<td>87</td>
<td>W</td>
<td>119</td>
<td>w</td>
</tr>
<tr>
<td>24</td>
<td>^X</td>
<td>56</td>
<td>8</td>
<td>88</td>
<td>X</td>
<td>120</td>
<td>x</td>
</tr>
<tr>
<td>25</td>
<td>^Y</td>
<td>57</td>
<td>9</td>
<td>89</td>
<td>Y</td>
<td>121</td>
<td>y</td>
</tr>
<tr>
<td>26</td>
<td>^Z</td>
<td>58</td>
<td>:</td>
<td>90</td>
<td>Z</td>
<td>122</td>
<td>z</td>
</tr>
<tr>
<td>27</td>
<td>^[</td>
<td>59</td>
<td>;</td>
<td>91</td>
<td>]</td>
<td>123</td>
<td>{</td>
</tr>
<tr>
<td>28</td>
<td>^\</td>
<td>60</td>
<td>&lt;</td>
<td>92</td>
<td>\</td>
<td>124</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>^]</td>
<td>61</td>
<td>=</td>
<td>93</td>
<td>]</td>
<td>125</td>
<td>}</td>
</tr>
<tr>
<td>30</td>
<td>^^</td>
<td>62</td>
<td>&gt;</td>
<td>94</td>
<td>^</td>
<td>126</td>
<td>~</td>
</tr>
<tr>
<td>31</td>
<td>_</td>
<td>63</td>
<td>?</td>
<td>95</td>
<td>_</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>{Space}</td>
<td>64</td>
<td>@</td>
<td>96</td>
<td>~</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix C: Inker Communication Port Errors

<table>
<thead>
<tr>
<th>Constant</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Event Break</td>
<td>1001</td>
<td>Break signal received</td>
</tr>
<tr>
<td>Com Event Frame</td>
<td>1004</td>
<td>Framing error</td>
</tr>
<tr>
<td>Com Event Overrun</td>
<td>1006</td>
<td>Port overrun</td>
</tr>
<tr>
<td>Com Event Rx Over</td>
<td>1008</td>
<td>Receive buffer overflow</td>
</tr>
<tr>
<td>Com Event Rx Parity</td>
<td>1009</td>
<td>Parity error</td>
</tr>
<tr>
<td>Com Event Tx Full</td>
<td>1010</td>
<td>Transmit buffer full</td>
</tr>
<tr>
<td>Com Event DCB</td>
<td>1011</td>
<td>Unexpected error retrieving device control block (DCB) for the port</td>
</tr>
</tbody>
</table>
Appendix D: Inker Settings

The following settings are the recommended starting point for the Inker. Document any deviation from these setting during installation.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Recommended Setting for Matthews 8400</th>
<th>Actual Setting at Installation</th>
<th>Adjustments</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Trigger</td>
<td>2.5”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulse rate</td>
<td>4765 p/ft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>80%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Direction</td>
<td>left</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dot size</td>
<td>300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Margin</td>
<td>0.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spacing</td>
<td>0.048 inches</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix E: Parts List
<table>
<thead>
<tr>
<th>Additional Parts</th>
<th>Company</th>
<th>DOD 5100 Part #</th>
<th>DOD 5400 Part #</th>
<th>DOD 8400 Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>MiTek Inker kit (entire assembly from Matthews)</td>
<td>Distributor Manufacturer MiTek</td>
<td>094DOD5100 DOD5100 Not available</td>
<td>094DOD5400 DOD5400 Not available</td>
<td>094DOD8400 DOD8400 78848-901</td>
</tr>
<tr>
<td>Printer HD connection Kit (2 heads only)</td>
<td>Distributor Manufacturer MiTek</td>
<td>094C4345-504-00 C4345-504-00 168129</td>
<td>094C4345-504-00 C4345-504-00 168129</td>
<td>094C4345-504-00 C4580-501-00 168129</td>
</tr>
<tr>
<td>Relay, module, 010011.17, Rb122ar, 110V AC/DC(Entr)</td>
<td>MiTek</td>
<td>514186</td>
<td>514186</td>
<td>514186</td>
</tr>
<tr>
<td>Cable, SOW #16/4, from stationary enclosure to PC enclosure</td>
<td>MiTek</td>
<td>—</td>
<td>—</td>
<td>508112</td>
</tr>
<tr>
<td>Filter for ink or cleaner reservoir</td>
<td>Manufacturer (Matthews)</td>
<td>—</td>
<td>—</td>
<td>A3928-503-00</td>
</tr>
<tr>
<td>Cap and stick assembly for ink or cleaner reservoir</td>
<td>Manufacturer (Matthews)</td>
<td>—</td>
<td>—</td>
<td>B4128-501-00</td>
</tr>
<tr>
<td>Punch tag to track filter changes</td>
<td>Manufacturer (Matthews)</td>
<td>—</td>
<td>—</td>
<td>MS795-508-00</td>
</tr>
</tbody>
</table>
# Appendix F: Drawing List

<table>
<thead>
<tr>
<th>Drawing Description</th>
<th>Drawing #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inker Assembly w/ Conveyor and Stand</td>
<td>78830-501 and -502</td>
</tr>
<tr>
<td>Inker Head, Assembly w/ Stand</td>
<td>78848-501</td>
</tr>
<tr>
<td>Kit, Electrical for Saw</td>
<td>90458</td>
</tr>
<tr>
<td>Kit, Electrical for Saw</td>
<td>90483</td>
</tr>
<tr>
<td>w/ Touch Screen Computer</td>
<td></td>
</tr>
<tr>
<td>w/ PC Enclosure</td>
<td>90503</td>
</tr>
<tr>
<td>Enclosure, PC</td>
<td></td>
</tr>
<tr>
<td>Enclosure, Touch Screen</td>
<td>90504</td>
</tr>
<tr>
<td>Cable, Matthews Printer</td>
<td>92149</td>
</tr>
</tbody>
</table>
## Appendix G: Readers’ Comments

**Instructions:**
Please fill out as much information as possible. Attach extra sheets as needed.

<table>
<thead>
<tr>
<th>Manual 001070</th>
<th>MiTek Inker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation and Maintenance Manual</td>
<td>MiTek (Matthews) Inker Wood Truss Component Marking System</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recommendation</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Reason for Recommendation</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Your Name</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>Address</td>
</tr>
<tr>
<td>Telephone</td>
<td></td>
</tr>
</tbody>
</table>

**Please mail this form to:**
MiTek
Machinery Division
301 Fountain Lakes Industrial Drive
St. Charles, MO 63303
Attn: Engineering Manager

**Or Fax this form to:**
(636) 328-9218
Attn: Engineering Manager

If you do not receive a reply within 45 days, please contact our Customer Service Department by phone and ask for a Documentation Specialist or the Engineering Manager: 800-523-3380.
Comments:

Compared to other truss machinery manufacturer’s documentation, how would you rate this document?

- Poor  - Fair  - Good  - Excellent

Rate the quality of service that was provided to you on the following items:

<table>
<thead>
<tr>
<th>Quality of Service</th>
<th>Poor</th>
<th>Fair</th>
<th>Good</th>
<th>Excellent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchased Equipment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delivered on time</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Installation process</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Technician</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Does the machine work as promised</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Does it handle the production load</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operations and Maintenance Manual</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Content</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accuracy</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clarity</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Completeness</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Examples/Illustrations</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Readability</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Other Suggestions:
Appendix H: Matthews 8400 Operator Manual
Thank you for choosing this JET·A·MARK product

We hope that this manual will be one of the reasons you choose to buy your next product from us. Therefore any suggestions which can lead to the increased quality of our instruction manuals will be gratefully received.

Please send any suggestions to this address:

MATTHEWS SWEDOT AB
Technical Documentation
Gamlestadsvägen 8
S-415 02 Göteborg
SWEDEN

techdoc@swedot.se

Keyboard Hotkeys

While in the menu structure or any Tool's work area, press:

- F1 to get to File Message
- F2 to get to File Object Text
- F3 to get to File Object Graphic
- F4 to get to File Object Barcode

- F5 to get to File Object Counter
- F6 to get to File Object Clock
- F7 to get to File Object Timecode
- F8 to get to File Object Favourites

Selecting a Message For Printout

Control Panel - Only for selecting Messages with names consisting of 3 digits.

1. Press [select] to select (highlight) one of the digits in the display window.
2. Press [change] to change the selected digit.
3. Repeat steps 1 and 2 to change other digits.
4. Press [remaining] until none of the digits in the display remain.

Press Print and select a Message.

Stopping the Printout

Control Panel


The Message, currently selected for printout, will be cleared.

Flushing All Print Heads

Control Panel

1. If the print head has this function, press [ink] and [cleaner fluid] together to switch between ink and cleaner fluid and wait until the indicator lamps show that the change has been made.
2. Press [for at least 1 second.]
Quick Reference Guide
For more complete information, please see the Operator Manual.

Keyboard Hotkeys
While in the menu structure or any Tool's work area, press:

- **F1** to get to File ➤ Message
- **F2** to get to File ➤ Object ➤ Text
- **F3** to get to File ➤ Object ➤ Graphic
- **F4** to get to File ➤ Object ➤ Barcode
- **F5** to get to File ➤ Object ➤ Counter
- **F6** to get to File ➤ Object ➤ Clock
- **F7** to get to File ➤ Object ➤ Timecode
- **F8** to get to File ➤ Favourites

Selecting a Message For Printout

**Control Panel** - Only for selecting Messages with names consisting of 3 digits.

1. Press [select] to select (highlight) one of the digits in the display window.
2. Press [↑] to change the selected digit.
3. Repeat steps 1 and 2 to change other digits.
4. Press [select] until none of the digits in the display remain.

Press Print and select a Message.

Stopping the Printout

**Control Panel**
Press [select] for about 1 second.
The Message, currently selected for printout, will be cleared.

Flushing All Print Heads*

**Control Panel**
* Only applies to this CPU module.
1. If the print head has this function, press [select] to select ink or cleaner fluid
   and wait until the indicator lamps show that the change has been made.
2. Press [select] for at least 1 second.
Introduction
About This Manual_3
Symbols Used_3
History_4

Overview
Part Names and Functions
System Descriptions_5
The S.C.I. F.I. 3400 and DOD®8400 Control Units_6
The R44 Unit_7
Print Heads_7
Keyboard_7

Operating
Getting Started
Getting Around the Menu Structure_9
Using Tools_10
Shortcuts_12
Tutorial_13

Creating and Deleting Objects
General Points on Objects_19
Creating a Text Object_19
Creating a Graphic Object_19
Creating a Barcode Object_22
Creating a Counter Object_24
Creating a Clock Object_27
Creating a Timecode Object_28
Deleting Messages, Objects and Favourites_29

Creating Messages
Before Creating Your First Message_30
Creating a Message_32
Test-Printing a Message_34
Saving a Message_34
Editing a Message_34
Changing the Print Attributes_37

Continued...
Introduction

About This Manual

The instructions in this manual are in the order one would follow when familiarising oneself and learning how to operate your printer. It is, therefore, recommended that the reader should carry out the instructions in the order that they appear.

The correct sequence of events is:

1. Overview
   “What does that button do?”
   A description of each part of the system.

2. Operating
   “How do I print a Message?”
   Everything you need to know to create, edit and print Messages. The Tutorial, in this chapter, is a good place to start.

3. Changing Installation Setup
   “How do I adapt the printer to an installation change?”
   Need to adapt the program to a new system setup? This is how it’s done.

4. Changing Message Setup
   “How do I change the spacing setting for new Messages?”
   Here’s how to change the default Message settings for all new Messages.

5. Changing Printout Setup
   “How do I print a Message a certain number of times?”
   Here’s how to change the printout settings for all Messages.

For more information please see the Technical Manual.

Symbols Used

At the beginning of many of the instructions in this guide, a line of text that looks something like this: File › Message › Print Attr › Dot Size, can be found. This is the “path” you should follow, via the menu structure and, if necessary, the Tool buttons, to get to the function described.

Words separated by arrows ( › ) are Menu items.

For example:

File › Message
means "Select the menu items File and then Message and then press the Enter key”.

Words preceded by pointing hands ( ﬁsh) are Tool buttons or parameters.

For example:

ﬁsh Print Attr ﬁsh Dot Size
means "Press Print Attr and then select Dot size”.

For more information please see the Technical Manual.
History

Each Operator Manual has been written for a specific control unit software version or major hardware feature. The following table shows which manual should be used with which control unit and keyboard. **Note that in no way does this table show compatibility between software versions.**

<table>
<thead>
<tr>
<th>Manual version number</th>
<th>Manual issue date (month/year)</th>
<th>Control unit software version (language versions)</th>
<th>Keyboard software version number</th>
<th>Major updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>06/99</td>
<td>4.01#1031</td>
<td>2.1</td>
<td>Note 1</td>
</tr>
<tr>
<td>2</td>
<td>07/00</td>
<td>4.10#1036</td>
<td>2.2 or 2.3</td>
<td>Note 2</td>
</tr>
<tr>
<td>3</td>
<td>05/01</td>
<td>4.20#1038</td>
<td>2.2 or 2.3</td>
<td>Note 3</td>
</tr>
<tr>
<td>4</td>
<td>04/03</td>
<td>5.00#1048</td>
<td>5.00 and above</td>
<td>Note 4</td>
</tr>
<tr>
<td>5</td>
<td>01/04</td>
<td>5.60#1062</td>
<td>5.70#1063</td>
<td>Note 5</td>
</tr>
<tr>
<td>6</td>
<td>08/04</td>
<td>6.00#1072</td>
<td>6.10#1073</td>
<td>Note 6</td>
</tr>
</tbody>
</table>

(a) Shown at start-up in the control unit display.
(b) The chips are marked with this number on the CPU board.
(c) Shown at start-up in keyboard display.
(d) Features for this version are as compared to the DOD5000 (forerunner to these units).
(e) Supplement to manual.

**Major Updates Notes**

- **Note 1:** Additional spacing setting • Set unit name via control panel • Temporarily leave editor with Menu key on keyboard
- **Note 2:** Select area of message for printout • Message length increased • Cursor coordinates in display • Imported graphics and bar codes allowed to extend beyond upper message confines • Terminate default now OFF
- **Note 3:** AM/PM clocks • Predefined clocks and counters in memory • Driver board settings for 3200
- **Note 4:** New bar code types and parameters • Network setup from control panel • Driver board menu moved (3200 only) • Up to 64 nodes in network (instead of 99) • New error codes • Keyboard signals if wrong key pressed while in editor
- **Note 5:** Restructured user interface with pull-down menus, extensive on-line help and shortcuts • UNICODE • New CPU board • New housing • Language versions: 5.00 - English, Swedish, German, Dutch 5.10 - English, French, Italian, Spanish
- **Note 6** DOD5400 removed from manual, DOD8400 added to manual
- **Note 7** Master Functions • Support for BC 64mm print head • Language versions: 6.00 - English/Swedish/German 6.10 - English/Spanish/Italian 6.20 - English/German/Dutch 6.30 - English/Italian/French 6.40 - English/Czech/Polish
Part Names and Functions

Unless otherwise stated, the term ‘control unit’ shall also be read as ‘CPU module (R44)’.

System Descriptions

The S.C.I. F.I. 3400 and DOD•8400 Systems

Each printer controls print heads using input from equipment such as a speed encoder, a print activator, a PC or another control unit.

B - Print Head
The print head uses ink from the ink supply unit to mark a print target according to the signals received from the control unit.
For more information on a specific print head, please see the documentation received with the applicable head.

C - Ink supply unit
Used for supplying ink and cleaner fluid to the print head.
For more information on a specific ink supply unit, please see the documentation received with the applicable unit.

D - Print activator (option)
A print activator (usually of photocell type) is used to detect the presence of a print target and signal the control unit that it is time to print.

E - Speed encoder (option)
A speed encoder is a device which converts the motion of, for example, a conveyor line, into electrical pulses. The pulses are used by the control unit as a reference when automatically adjusting the horizontal gap between dots to suit the conveyor line speed.

A - Control Unit (not R44)
The S.C.I. F.I. 3400 is a small character printer which uses up to four 3000 series print heads for printing messages.
The DOD•8400 is a large character printer which uses up to four 8000 series print heads for printing messages.
The R44 System

A - The R44 unit
The R44 is made up of up to four CPU modules (control units) connected together in a network and enclosed in a single compartment.

A CPU module can be a S.C.I. F.I. 3400 or a DOD•8400 control unit.

Each CPU module controls its print head/s using input from equipment such as a speed encoder, a print activator, a PC or another control unit.

B - Print Heads
The print heads use ink from the ink supply unit to mark a print target according to the signals received from the control unit module.

In the example above B1 is from the 3000 series and B2 is from the 8000 series. This means that the R44 contains a S.C.I. F.I. 3400 CPU module and a DOD•8400 CPU module.

For more information on a specific print head, please see the documentation received with the applicable head.

C - Ink supply units
Used for supplying ink and cleaner fluid to the print heads.

In the example above C1 supplies print head B1 with ink and C2 supplies B2. Note that 3000 and 8000 series print heads require different ink types and must therefore use different ink supply units.

For more information on a specific ink supply unit, please see the documentation received with the applicable unit.

D - Print activator (option)
A print activator (usually of photocell type) is used to detect the presence of a print target and signal the CPU module that it is time to print.

E - Speed encoder (option)
A speed encoder is a device which converts the motion of, for example, a conveyor line, into electrical pulses. The pulses are used by the CPU module as a reference when automatically adjusting the horizontal gap between dots to suit the conveyor line speed.

The S.C.I. F.I. 3400 and DOD•8400 Control Units
These control units are also available without the built-in keyboard. See also “Using the Control Panel” on page 41.
The R44 Unit

The R44 unit is also available without the built-in keyboard. See also “Using the Control Panel” on page 41.

Print Heads

For information on a specific print head, please see the documentation received with the applicable head.

Keyboard

At Start-up

When the keyboard starts up it goes through the following procedure:

1. The keyboard version number is shown in the display and a buzzer sounds.
2. Communication is established between the keyboard and the control unit.
3. Necessary screen memory is tested and the world map splash is displayed.
4. RAM is tested after which the control unit software version number is displayed for a short period of time. If a RAM fault is detected a buzzer sounds informing the user that the keyboard cannot be used and must be serviced.
5. If no faults are detected, the menu is displayed.

See also “Error Codes and Messages” on page 64.

(1) The keyboard starts up when it is connected to a control unit while it is switched on or when the control unit is switched on while the keyboard is connected to it.
Description of Keys

Note that the control unit or R44 can either have a built-in or an external keyboard. This information applies to both types.

Display

See also “Error Codes and Messages” on page 64.

Ink Supply Units

For information on a specific ink supply unit, please see the documentation received with the applicable unit.
Getting Started

Before using your Jet•A•Mark printer for the first time, it’s a good idea to familiarise yourself with all the parts of the printer and the equipment connected to it. The Overview section of this guide is a good place to start.

The next step is to get an understanding of how to use the printer.

A lot of effort has been put into making this product as user-friendly as possible, with a simple user interface, logically constructed tools, shortcuts, and help at the press of a button. But, as time is usually in short supply, being prepared is often the quickest way to get up and running, and that is where the Getting Started chapter comes in.

It is hoped that, at the end of these instructions, you will have learned the basics of printing with your Jet•A•Mark printer.

Note that the keyboard screen in this document is shown inverted (black text on white background instead of white on black). This is for reasons of clarity. The keyboard screen can not be set to black on white.

Getting Around the Menu Structure

The following describes how the keyboard keys are used to move around in the menu structure.

Use these keys to select items in any menu.

When a menu item with an arrow symbol (↑) is selected, a sub-menu appears.

The following shows how the arrow keys are used to move from menu to menu.

The menu key selects the top item of the main menu from anywhere in the menu structure.

Pressing  will always bring you here.
Some items have no arrow symbol. This means that the item is a Tool and can be opened.

Using Tools
A Tool is a window where changes are made or functions are carried out by the user. This is where Messages and Objects are created and functions are set. It’s in one Tool or another that you will be spending most of your time while using this printer, so it’s a good idea to learn which keys do what.

Moving Around in a Tool
The 2-dot key switches the focus (or the active area) between the work area and the Tool buttons.

Tool buttons are selected using the arrow, Home and End keys.
Press the selected Tool button by pressing the Enter key.
The word "Press" in combination with the word "button", in this guide, is used when the selected Tool button shall be activated by pressing the key on the keyboard.
Use the tab and arrow keys to move the focus to the next parameter. Press the Shift key together with the Tab key to move the focus in the opposite direction.
Press the Menu key to leave a Tool temporarily. This can be useful if, for example, you need to leave the Message Tool to create an Object for import into the Message you are creating.

Do not forget to go back to the Tool to save your work. Otherwise it will be lost when the printer is switched off.

Setting Radio Buttons
The 1-dot key is used to set radio (on/off) buttons.

Editing Text fields
The following example shows how the and keys are used to edit a text. In this case the letter X is replaced by the letter D.
Selecting and Searching for Files

Use the following keys to select a file from a list.

1. Press Search.
2. Enter the full name of the file and then press Ok. The file will be selected.

Or
3. Enter the first part of the name of the file and then press Ok. All files with a name beginning with this character combination will be shown on the screen.

Press Search again to enter more characters to make a narrower search.

Remove all characters from the Search dialogue and press Ok to show all files.

Shortcuts

Why go the long way around when there is a quicker way?

With this in mind Hotkeys and Favourites have been incorporated into the program.

Hotkeys

Hotkeys are keys F1 to F8 on the keyboard. These are fixed shortcuts to the following Tools:

While in the menu structure or any Tool's work area, press:

- F1 to get to File † Message
- F2 to get to File † Object † Text
- F3 to get to File † Object † Graphic
- F4 to get to File † Object † Barcode
- F5 to get to File † Object † Counter
- F6 to get to File † Object † Clock
- F7 to get to File † Object † Timecode
- F8 to get to File † Favourites

Favourites

Favourites are user defined shortcuts to Messages and Objects. A favourite location is designated a key combination while the Message or Object is being saved to memory. From the menu structure or any Tool’s work area, the key combination is pressed to quickly get back to the location.

1. Press the Save button in any Message or Object Tool.
2. If no name is present, enter a name to save the Message or Object under and then press Options.
3. Enter one of the following 16 key combinations. This is the key combination used to return to this location (favourite).

   Press and hold Alt or Ctrl and press one of the F-keys F1 to F8.

To view existing Favourites, select Favourites under File.
To delete a Favourite, select Delete under File.

Getting Help

The best place to learn how to use your ink jet printer is in the chapter you are reading now. But later, if you need a quick reminder, go to the Help section in the menu.

If you are unsure about what will happen when you press a button, try pressing the key first. This will bring up a help text specifically for the function you are about to perform. This includes all Tool items in the menu structure.

Sometimes, pressing the key both a second and a third time (while the previous help text is being shown) will bring up more help.

Other Tips

• Instead of pressing an arrow key several times to get to the end selection of Tool buttons or items in a menu, try pressing the arrow key pointing in the opposite direction and you will get there quicker. And don’t forget the Home and End keys.

Tutorial

The following exercises will guide you through the process of creating a message and, at the same time, give you insight onto the build-up of the control unit menu structure.

It is important that all 7 exercises are carried out on the same occasion.

These exercises take you through the following procedures:

• Exercise 1 - Creating an Object
• Exercise 2 - Importing Objects into a Message
• Exercise 3 - Adding a Single-Message Text
• Exercise 4 - Test-Printing a Message
• Exercise 5 - Changing the Look of a Field
• Exercise 6 - Editing an Object
• Exercise 7 - Storing and Printing a Message

The Message created in this tutorial will be 32 dots in height although only the upper 16 dots will be used. This means that the exercises can be carried out with either a 16 or a 32 nozzle print head connected to the control unit.

Hopefully the message will look like this at the end of exercise 7.

Before starting exercise 1, please carry out the following:

• Make sure that the control unit has been properly installed and is ready to print.
• Check that the keyboard is connected.
• If you are unsure about how to use the keyboard, please see “Getting Started” on page 9, before proceeding.
Exercise 1 - Creating an Object

Two of the most important words, used in this manual, are “Message” and “Object”. Quite simply, a Message is a collection of one or more Objects which shall be printed onto a print target, and an Object is one of the following:

- An Object is a text, a graphic, a barcode, a counter, a clock or a timecode which has been stored in memory.

In this exercise a barcode, of type 2 of 5 (2/5 in the display), will be created.

1. In the menu structure (no Tool open), select File ➔ Object ➔ Barcode and press . Alternatively you could have pressed the hotkey F6 and you would have come straight to the Barcode Tool.

The barcode Tool is now displayed with a new (empty) barcode Object.

2. Each parameter can be changed, but we shall only enter the data which shall be encoded by the 2 of 5 barcode. Therefore, press the key so that Data is selected and then type 123.

3. Select the Tool buttons by pressing , go to Save using the arrow keys and press . Give the new barcode the name BC1 and then press F6 again. It is while you are saving that you can create a shortcut to an Object or Message. Read more about this at “Favourites” on page 12.

4. Leave the barcode Tool by pressing the Exit button or the key. The barcode has now been created and stored with the name “BC1”. The next step is to import it into a message.

Exercise 2 - Importing Objects into a Message

In this exercise a new Message shall be opened and the barcode, from exercise 1, shall be imported. Also one of the many graphic Objects, which are stored in all new control units, shall be imported.

Any object can be used in any number of Messages (or the same Message) while retaining a link to the original in memory. This means that a change made to an Object will be reflected in all Messages using that Object.

1. In the menu structure (no Tool open), select File ➔ Message and press . This
will open a new Message.

A quicker way of getting to the Message Tool is to press the \[F1\] hotkey while in the menu structure or in a Tool's work area.

The new message screen will now appear with a new (empty) Message and with the cursor in the top, left-hand corner of the Message work area (between the two horizontal lines).

2 Select the Tool buttons by pressing \[Ctrl\] + \[Enter\], go to Import and press \[Enter\].

3 Select Barcode and press \[Enter\] to show a list of barcode Objects stored in memory.

4 Using the arrow keys, select the barcode we just created, called BC1.

5 Select the Tool buttons by pressing \[Ctrl\] + \[Enter\], go to Ok and press \[Enter\].

Instead of pressing the \[Enter\] key and selecting Ok, just press \[Enter\] when the barcode’s name is selected.

The barcode called BC1 has now been imported into the Message so that the bottom of the barcode (including the text) is on the same line as the bottom of the cursor. This is always the case when importing Objects.

Notice that the barcode is only a single dot high. It is actually taller than this, but it has been compressed to fit.

To expand the barcode to its actual size it must be selected and edited. To do this, move the cursor one step to the left so that the bottom line of the cursor is over the bottom line of the Object field. When the cursor is positioned correctly the screen will show the field content (object type, name and size).

Enter edit mode by pressing \[Ctrl\] + \[Enter\] to get to the Tool buttons, and then press Edit. Now move the barcode down by pressing the \[Down\] key until it is at full height (Size shows 16x74). Press \[Enter\] when you’re ready.

You’ll learn more about changing the look of a field in Exercise 5.

Next we will import a graphic, but before we do, move the cursor a few steps to the right so that the graphic that we shall import doesn’t appear too close to the barcode.

6 Select and press Import. Now press Graphic to show a list of graphic Objects stored in memory.

7 We shall select graphic “8” but this time, instead of using the arrow keys to select the Object, press Search, enter the number “8” and press \[Enter\].

---

(a) For a complete list of hotkeys see “Hotkeys” on page 12.
Notice that the first Object it finds which has a name starting with the number 8 is now selected. As this is the Object we want, press \( \text{Enter} \) and the graphic will appear next to the barcode.

For more information, see “Importing Objects into a Message” on page 32.

**Exercise 3 - Adding a Single-Message Text**

We now have a Message containing two imported Objects, in this exercise we shall enter a text.

There are two ways of entering a text to a Message:

- One way is to create a text Object and import that into the Message. This type of text can be seen as a “multi-Message” text because the same text can be used in any number of messages.
- The other way, and the way we shall use here, is to enter a text directly into the Message. This is a “single-Message” text because it can only be used in the Message into which it was entered.

1. Move the cursor a few steps to the right so that the text is not entered too close to the graphic.
2. Enter the text “ABCD” and then press \( \text{Enter} \).

As soon as \( \text{Enter} \) was pressed the text field was completed. If any new text is entered it will be contained in a new field.

**Exercise 4 - Test-Printing a Message**

A test-print can be carried out at any time during the creation or editing of a Message. Before carrying out the next step, make sure that it is ok to activate a printout.

1. Press Test Print.

As long as “Ready to print” is shown in the display the control unit will print this Message each time a printout is activated (a print target passes the printout activator).

2. Press any key to exit the test-print function and stop printing.

**Exercise 5 - Changing the Look of a Field**

Each object in the Message we have created is contained in its own field and each field can be selected and its appearance changed.

In this exercise we shall select the text “ABCD”, move it to a new position and make it bold (dark).

1. Using the arrow keys, move the cursor so that the bottom line of the cursor is on the bottom line of the text field. The first few letters of the selected text will appear in the bottom, left corner of the
screen to help identify the field.

<table>
<thead>
<tr>
<th>Message</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Save</td>
<td>Import</td>
</tr>
<tr>
<td>Font</td>
<td>Edit</td>
<td>Line</td>
</tr>
<tr>
<td>Field Attr</td>
<td>Print Attr</td>
<td>Text Print</td>
</tr>
<tr>
<td>123ABC</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The first few letters of the text are shown here when a single-Message text field is selected.

2 Press Edit.

3 Move the text up a few steps by holding the \[Page Down\] key in and, at the same time, pressing the \[Line Feed\] key five or six times.

4 While still in Edit mode press Field Attr and then press the \[Page Down\] key once so that Dark is selected.

5 Press \[Enter\].

As you see, the characters in the text are now bold.

6 Press \[Enter\] to leave the edit function.

---

The Message can be set so that all coming text entries or imports are enhanced in a specific way. For more information see “Setting the Field Attributes” on page 36.

Exercise 6 - Editing an Object

As mentioned earlier, an object can be used in any number of Messages while retaining a link to the original in memory.

In this exercise we shall see that a change made to an object will also change any copies that have been imported into Messages.

Our Message contains an imported barcode which encodes data “123”. We shall change the data to “456”.

1 Press the \[Esc\] key. This exits the message without having to save our changes first. Any changes that were made before the Menu key was pressed, are retained as long as the control unit is not switched off or the keyboard is disconnected.

2 Select File \[File\] Object \[Barcode\]

3 When the new barcode screen is displayed, press Open and select our barcode which is called “BC1”. Press \[Enter\].

4 Select Data and press \[Del\] so that “123” is removed.

5 Enter “456” and then press Save and \[Enter\] to keep the same barcode name.

6 Now return to the Message. Try going the quick way by pressing the \[F5\] hotkey.

As you see, the screen still shows the “123” barcode.
This is because we used the key to leave the Message. A Message must be saved and reopened for it to be updated on the screen. We will see this more clearly in the next exercise.

The Message is now ready. The next and final exercise describes how the Message is stored in memory and printed.

**Exercise 7 - Storing and Printing a Message**

1. Press Save.
2. Give the Message a name (of up to 8 characters) that says something about its contents or onto what print target it shall be printed. In this case “MSG1” will do.
3. Press .
   All that’s left to do now is to select the message for printout.
4. Press the key twice so that Print in the main menu is selected.
5. Press and select MSG1.

MSG1 is now displayed for a final check before printout. Notice that the barcode is now showing the correct data (456).

6. Press Enter.

The control unit will now print this Message each time a printout is activated (a print target passes the printout activator).

To stop the Message being printed press Print and then Stop Print.

Congratulations, you have now created and printed your first message.

There are many more functions than those covered in these short exercises so it is well worth while taking the time to read through this manual and experiment so that you can utilise the system better to achieve your printing needs.
Creating and Deleting Objects

A Message is a collection of one or more Objects which shall be printed onto a print target. An object is one of the following:

Objects are stored in memory and can be used in any number of Messages (or the same Message) while retaining a link to the original. This means that a change made to an object will be reflected in all Messages using that object.

The following describes how different object types are created and stored in the memory and how Messages and Objects are deleted.

See also “Creating Messages” on page 30.

General Points on Objects

• Changes made to objects will be reflected in the Messages or barcodes into which they have been imported.

• A Message which is currently selected for printout will not be affected by any change made to an object used in that Message. To update the Message it must be reselected for printout.

Creating a Text Object

File ▶ Objects ▶ Text

The text editor is used to create, edit and store a text which shall be imported into barcodes or Messages for printing.

For a description of the keyboard keys associated with text editing, see “Editing Text fields” on page 11.

Only the actual text characters are entered here. This means that any change to the text’s appearance, such as choice of font and how it shall be enhanced, is made to the text field after it has been imported into the Message.

These buttons appear when you open the Text Tool:

Open For opening a text object which is stored in memory.
Save For giving a text object a name and storing it in memory.
Show For displaying all text Objects in memory. Both the text object’s name and the beginning of its text is shown.
Exit For leaving the text Tool. If the text has not been saved you will be given the option to do so.

Creating a Graphic Object

File ▶ Objects ▶ Graphic

The Graphic Editor Tool is used to create, edit and store, a graphic object which shall be imported into Messages for printing.
See “Graphic Objects” on page 72 for a description of the graphics stored in memory.

These buttons appear when you open the Graphic Tool:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>For opening a graphic object which is stored in memory.</td>
</tr>
<tr>
<td>Save</td>
<td>For giving a selected area of the graphic a name and storing it in memory. See “Saving a Graphic” on page 22.</td>
</tr>
<tr>
<td>Zoom</td>
<td>For enlarging the view. See “Zooming In and Out” on page 21.</td>
</tr>
<tr>
<td>Exit</td>
<td>For leaving the Graphic Tool. If the graphic has not been saved you will be given the option to do so.</td>
</tr>
<tr>
<td>Line</td>
<td>For drawing a line. See “Drawing a Line or Rectangle” on page 20.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>For drawing a rectangle. See “Drawing a Line or Rectangle” on page 20.</td>
</tr>
<tr>
<td>Dot</td>
<td>For drawing a single dot.</td>
</tr>
<tr>
<td>Clear</td>
<td>For erasing a selected area of the graphic. See “Clearing or Moving an Area of the Graphic” on page 21.</td>
</tr>
<tr>
<td>Move</td>
<td>For moving a selected area of the graphic. See “Clearing or Moving an Area of the Graphic” on page 21.</td>
</tr>
<tr>
<td>Copy</td>
<td>For making a copy of a selected area of the graphic. See “Copying a Graphic” on page 22.</td>
</tr>
</tbody>
</table>

**Drawing a Line or Rectangle**


1. Position the bottom, left hand point of the cursor at the start position of the line or rectangle.
2. Press Line or Rectangle.
3. Use the arrow keys to draw the line or rectangle. Pressing the Control key together with one of the arrow keys will draw the graphic in larger steps.
4. To move the line or rectangle, press Shift together with one of the arrow keys. Pressing the Control key together with Shift and one of the arrow keys will move the graphic in larger steps.
5. Press done.

**Drawing a Dot**

1. Position the cursor where the dot shall be drawn and press Dot.
2. Reposition the cursor and draw the next dot.

Notice that pressing Dot again, without changing the cursor position, will clear the dot.

A quicker way to draw and clear dots is to press the space bar on the keyboard. This can be done without having to move the focus to the Tool bar and pressing Dot.
Selecting an Area of the Graphic

Some of the functions in the Graphic Tool require that an area of the graphic is selected before the function is performed. The following shows how this is done.

1. Move the cursor to the bottom left point of the area to be selected.
2. Press the appropriate Tool button.
3. The whole graphic is now selected. If the selection needs to be changed, use the arrow keys in combination with the Shift and Ctrl keys according to the following.

- Press Select All at any time to switch between selecting the whole graphic and the previous selection.

Zooming In and Out

It is possible to zoom in and out at any time during the creation of a graphic. Note that zoom only changes the graphic’s viewing size on the keyboard screen. The printout size is not changed.

1. Press Zoom.
2. Select 100%, 200% or 400% zoom and press Enter.

Clearing or Moving an Area of the Graphic

1. Move the cursor to any part of the graphic area using arrow keys.
2. Press Clear or Move.
3. Select the area to be cleared or moved. See “Selecting an Area of the Graphic” on page 21.
4. Press Enter.
   - If Clear was pressed at step 2, the area will now be deleted.
   - If Move was pressed at step 2, the area can now be moved with the arrow keys. Press Enter when the area is in the new position.
Copying a Graphic
1. Press Copy.
2. Select the area to be copied. See “Selecting an Area of the Graphic” on page 21.
3. Press Enter.
4. Using the arrow keys, move the outline to the new location.
5. Press Enter.

Flipping a Graphic
1. Press Flip.
2. Select the area to be flipped. See “Selecting an Area of the Graphic” on page 21.
3. Press Enter.
4. Choose the flipping method according to the following.
   Note that by combining more than one method it is possible to achieve any 90 degree rotation and press Enter.
5. Diagonal flip is only available if the selected area has equal width and height.

Saving a Graphic
1. Press Save.
2. The whole area containing graphics will now be selected. If necessary use the arrow keys to change the size of the surrounding rectangle, and Enter together with one of the arrow keys to reposition it.

   Make sure that no space below the graphic is selected as this will make selecting difficult when the graphic has been imported into a Message.
   See also “Selecting an Area of the Graphic” on page 21.

Creating a Barcode Object

File → Objects → Barcode
The Barcode Tool is used to create, edit and store a barcode Object which shall be imported into Messages for printing.

To create a barcode:
1. Set each parameter as required. See “Barcode Parameters” on page 23, for a description of each parameter.
2. At Data, enter the characters that the barcode shall represent (encode).
   • The Tool will only accept legal data for the selected barcode type.
   • The Tool will not allow more than the maximum number of characters for the se-
3 Press Save, give the barcode a name and store it in memory.

**Barcode Parameters**

See “Barcode Information” on page 68, for a complete list of parameter settings.

**Type**

Choose one of the barcode types. The characters in the Data field will be adapted to the selected barcode type.

**Ratio**

Choose one of the barcode ratio settings.

**Adjust**

Choose whether or not to adjust for ‘bleeding’. Bleeding occurs when the ink spreads on the print target surface causing the bars to become too wide. If Yes is chosen, the printer will compensate for this by altering the width of bars and spaces. Note that this will increase the total length of the barcode.

<table>
<thead>
<tr>
<th>Type</th>
<th>Ratio</th>
<th>Adjust</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1:2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1:3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2:4</td>
<td></td>
</tr>
</tbody>
</table>

- **Ratio 1:2**
- **Ratio 1:3**
- **Ratio 2:4**

**Height**

Choose one of the height settings. This is the barcode’s preferred total height in dots, including the interpretation. See “Exercise 2 - Importing Objects into a Message” on page 14, for more information.

Example: `HEIGHT: 16` — Height in dots

**Font**

Choose one of the fonts listed by name (height x width in dots), for the barcode’s interpretation (human readable characters under the barcode). If None is selected the barcode will be printed without interpretation.

**Country**

Choose the method of grouping the barcode’s interpretation (human readable characters under the barcode). This option will only appear if the selected barcode’s interpretation can be grouped in any other way than the standard setting.

- **(a)** The height may be less when imported into a Message. See “Importing Objects into a Message” on page 32, for more information.

**Entering Special Characters**

Special characters such as function codes and characters from sets A, B or C, can be entered into a EAN-128A, EAN-128B, EAN-128C or CODE-128 barcode. See also “Character Set For CODE-128” on page 70.

1. At Type select EAN-128A, EAN-128B, EAN-128C or CODE-128.
2. Select Data.
3 Press the Spec. Char button, and choose one of the following:

<table>
<thead>
<tr>
<th>Special character</th>
<th>Description</th>
<th>Display shows...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A&lt;-&gt;B</td>
<td>Press to shift between modes (character set) A and B for input of the next single character. After the character has been entered the original mode will be returned to.</td>
<td>O</td>
</tr>
<tr>
<td>FNC-1</td>
<td>Select a function code according to the CODE-128 standard.</td>
<td>1</td>
</tr>
<tr>
<td>FNC-2</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>FNC-3</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>FNC-4</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>SET-A</td>
<td>Press to change to character set A, B or C for input of the next characters.</td>
<td>A</td>
</tr>
<tr>
<td>SET-B</td>
<td></td>
<td>B</td>
</tr>
<tr>
<td>SET-C</td>
<td></td>
<td>C</td>
</tr>
</tbody>
</table>

**Importing Data**

The text based Objects Text, Counter, Clock and Timecode can be imported into the barcode.

The control unit will only allow import of data which entirely consist of characters which are correct for the selected barcode type.

1 Move the cursor to Data and press Import.
2 Select the type of data to be imported and then select the desired file.

**Creating a Counter Object**

File Objects Counter

The Counter Tool is used to create, edit and store, an alphabetic, numeric or alphanumeric Counter Object which shall be imported into barcodes or Messages for printing.

Next  The counter will start with this value.
From  The counter shall restart from this value.
To  The value that the counter shall count to (the To value is also included in the count).
By  The number that the counter shall step By.
Period  How often the counter shall be updated with the By setting.
I&O  As the letters I and O can be confused with the numbers 1 and 0 the counter can be set to exclude them from the counter.

A counter can consist of up to 10 characters and can be an up-counter or a down-counter.

1 Set the counter according to the following. See also the rules and examples below.

A counter can consist of up to 10 characters and can be an up-counter or a down-counter.

(a) If Master Functions is active, all master clocks are synchronised with the master clock in unit 01.
Press Save, give the counter a name and then press Enter.

**Counter Rules**
- Next, From and To must always have the same number of characters.
- Next, From and To must always have numbers and letters in the same positions.

*Example:
- Next: A1A
- From: A1A
- To: C3C

- If a space character shall be used to separate characters, the space must be included in the same position(s) in Next, From and To.

*Example:
- Next: AA 1
- From: AA 1
- To: CC 3

- Only UPPER CASE letters may be used.

**Counter Examples**

Print activation (Trig) sensitive up-counter
Counts and prints 1 to 4

<table>
<thead>
<tr>
<th>Next</th>
<th>By</th>
<th>From</th>
<th>Period</th>
<th>To</th>
<th>I &amp; O</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>4</td>
<td>Yes</td>
<td>Trig</td>
</tr>
</tbody>
</table>

Print activation (Trig) sensitive down-counter
Counts and prints 4 to 1

<table>
<thead>
<tr>
<th>Next</th>
<th>By</th>
<th>From</th>
<th>Period</th>
<th>To</th>
<th>I &amp; O</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>1</td>
<td>Yes</td>
<td>Trig</td>
</tr>
</tbody>
</table>
Print activation (Trig) sensitive, alpha-numeric up-counter
Counts and prints A1 to B9

Next: A3  By: 1
From: A1  Period: 1
To: B9  I & O: Yes
Cause: Trig

Printout (Mark) sensitive, alphabetic counter
Counts and prints A to Z, three times each

Next: J  By: 1
From: A  Period: 3
To: Z  I & O: No
Cause: Mark

Counter updates counter
In this example, one counter updates another counter. Both counters are imported into the same Message.

Invisible counter
This function is useful if you want a counter to count without being printed.

Counter name: 0-3

Next: 3  By: 1
From: 0  Period: 1
To: 3  I & O: Yes
Cause: Trig

Counter name: 1-9999

Next: 0001  By: 1
From: 0000  Period: 1
To: 9999  I & O: Yes
Cause: Trig

Do not import this counter into the Message.
Creating a Clock Object

File ▶ Objects ▶ Clock

The Clock function is used for creating, editing and storing a Clock Object which shall be imported into barcodes, Messages or which shall be used by Timecodes. Each Clock Object is made up of one or more time related blocks such as the name of the month or the number of the day.

One thing that all Clock Objects have in common is that they all keep time with the master clock (see below).

If Master Functions is active, all master clocks are synchronised with unit 01.

See also “Clock Objects” on page 74.

These buttons appear when you open the Clock Tool:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>For opening Clock Objects stored in memory. See “Clock Objects” on page 74 for a list of Clock Objects stored in memory.</td>
</tr>
<tr>
<td>Save</td>
<td>For storing the Clock Object in memory.</td>
</tr>
<tr>
<td>Show</td>
<td>For listing all Clock Objects stored in memory.</td>
</tr>
<tr>
<td>Exit</td>
<td>For leaving the Clock Tool.</td>
</tr>
<tr>
<td>Format</td>
<td>For setting what form the clock shall take.</td>
</tr>
<tr>
<td>Offset</td>
<td>For setting the difference in time between this clock and “true-time”.</td>
</tr>
</tbody>
</table>

Applying DST Automatically adjusts the clock for daylight saving time (DST) changes.

24h/12h For choosing the time format. Choose between 24 hour format or one of two 12 hour formats (with or without a space between the time and AM/PM).

1 Enter the Clock Object Tool.

A Clock Object containing one of each of the available time related blocks, is shown. A new clock is created by editing the format of this clock.

2 Press Format, select the block which is to be changed or removed from the clock and press Edit or .

Clock Objects are made up of time related building blocks to show the date and time in different ways. These are relative to the master clock.

Clock Objects are imported into Messages for printing.

These buttons appear when you open the Clock Tool:

Order Position of block in clock.
1 = first (far left), 2 = next left, etc.

Length The number of characters to be used. For example, if set to 2, the year 2003 will be printed as 03.

Switch off if the block shall be removed from the Clock. Month Name and Weekday Name can either be used (On) or not used (Off). Their length cannot be changed.

Separator The character which shall be used immediately to the right of the block to separate it from the next block.
Creating a Timecode Object

The Timecode function is used for creating, editing and storing a Timecode (shift code) object which shall be imported into Messages.

What's a Timecode?

A Timecode is a looping sequence of intervals with corresponding codes. Each code is only printed during its designated interval.

See also “Timecode Objects” on page 75, for a list of the Timecodes stored in memory at delivery.

These buttons appear when you open the Timecode Tool:

- **Open**: For opening and editing an existing Timecode.
- **Save**: Store the Timecode object in memory.
- **Show**: For listing all Timecodes stored in memory.
- **Exit**: Leave the Timecode Tool.
- **Define**: Edits the currently active Timecode or creates a new.

This is where the intervals are defined, interval codes are assigned and the loop time is set.

- **Clock**: Selects a Clock Object that this Timecode shall use.

The Timecode will start using the new clock after it has been saved. If no clock is selected, the clock set at installation will be used.

*If Master Functions is active, all master clocks are synchronised with unit 01.*

- **View Now**: Lists all intervals with corresponding codes for the active Timecode.

This list is sorted chronologically.

(a) See “Timecode Objects” on page 75 for a description of example Timecodes stored in memory.

1. Press Define to enter the date, time and code for each interval. This is also where the date and time for looping the Timecode is entered (Loop back).
2. If necessary, press Clock to select a Clock Object that the Timecode shall use.
3. Press Save to store the Timecode in memory.

A Timecode Example

This example shows how to set up a Timecode which will print a different text during each of three 8 hour intervals, and then loop back to the start.

1. Enter the Timecode Tool and press Define.
2. At Interval #01, set:
   - Hour to 00
   - Minute to 00 (for midnight)
Deleting Messages, Objects and Favourites

Code to "Shift 1" and then press Next.

3 At Interval #02: set: Hour to 08 Minute to 00 (for 8 o'clock in the morning), Code to "Shift 2", and then press Next.

4 At Interval #03: set: Hour to 16 Minute to 00 (for 4 o'clock in the afternoon), Code to "Shift 3", and then press Next.

The next step is to enter the date and time at which the interval, set at step 4, shall end. This is also when a new cycle shall begin (loop).

5 Press Loop back and set: Day to tomorrow's date Hour to 00 Minute to 00 (for the following midnight), and press Done.

The three intervals are now listed in numeric order, starting with the earliest time. The code for each interval is also shown.

6 Press View Now to see the three periods in chronological order.

The View Now function shows the periods in chronological order with the current period at the top. They may be in a different order if the time where you are not between 08:00 and 16:00.

7 Press Save and give the Timecode a name.

Deleting Messages, Objects and Favourites

Press Delete and then select Message or Object type.

2 Select the name of the file which shall be deleted or press Delete All to delete all files of the selected type.

3 If a single file was selected, Show can now be pressed to preview the contents of the selection. If necessary, use the and keys to preview information outside of the screen area.

4 If the selection is correct, press Delete and confirm deletion by pressing Yes. A Message being printed will not be affected by Delete until it is cleared or another Message is selected for printout.

5 If the selection is correct, press Delete and confirm deletion by pressing Yes.

(a) Objects imported into Messages are not deleted together with the Messages themselves.
Creating Messages

Before Creating Your First Message

The following pages deal with the different aspects of Message creation. For more basic information on Message build-up, etc. please see the “Tutorial” on page 13. It will walk you through how a Message is put together.

What's a Message?

A Message is, quite simply, a collection of information which is printed by the control unit. A Message can contain one or several imported “Objects” which have been saved in memory.

An imported Object is a linked copy of the original which means that any change made to the original will affect all Messages that contain a copy. See “Creating and Deleting Objects” on page 19.

When an Object has been imported into a Message it is contained in its own field which can be selected for making adjustments. See “Selecting a Field for Editing” on page 37.

The different Object types are:

Text - Graphics - Barcode - Counter - Clock - Timecode

A Message can also contain a single-Message text or line or rectangle which has been entered directly (not imported) into the Message. The term ‘single-Message’ is used because the Objects are only used in one Message whereas other, imported Objects can be used in many Messages.

Printing With More Than One Print Head

(S.C.I. F.I. 3400 only)

Before creating a Message it is important to know how many print heads are being used to print. If only one print head is being used then printing is straightforward and the reader can skip this information and go straight to “Creating a Message” on page 32.

If a Message is to be divided up between more than one print head it is a good idea to find out which print head shall print which portion of the Message so that the Message can be created accordingly.
If you are unsure which print heads are connected to the control unit press Show and then Driver Board and the screen information will appear.

**Nozzles in total:**
**Nozzles are grouped as:**
**Type of head:**

The circled symbols refer to the diagram below.

The following shows how the Message will be shared amongst the available print heads, according to the settings above.

### Positioning of Fields in Message Area

When two or more print heads are being used to print, the software automatically distributes each part of the Message to the print heads so that the printout looks, as much as possible, like the Message.

It is important that the fields in the Message are positioned according to the following so that the software can make adjustments automatically:

- **Each field must be positioned in the Message so that it is printed by a SINGLE print head.**

Example:
A 32 dot Message printed by one 16 valve head and two 7 valve heads.

If any field is positioned incorrectly the software will make no adjustment and the horizontal strips that make up the Message will be displaced horizontally.
Creating a Message

The Message Editor Tool is used for creating and editing Messages. These buttons appear when you open the Message Tool:

- **Open** For opening a Message stored in memory.
- **Save** For saving the active Message to memory.
- **Import** For importing an Object into the Message.
- **Exit** For leaving the Message Tool.
- **Font** For selecting a font for all new fields.

**Example:**
As the Message above contains incorrectly positioned fields no adjustment will be made and the Message will therefore be printed something like this (depending on the print direction).

---

**Importing Objects into a Message**

When an Object has been imported into a Message it is contained in its own field which can be selected for making adjustments. See “Selecting a Field for Editing” on page 37.

To import:

1. Position the cursor at the point where the Object shall be placed.
2. Press Import and select the required Object type.
3. Choose the desired Object and press Ok.

The Object will now appear at the cursor point.
Note that a barcode Object may look shorter than expected or the top of a graphic Object may pass the upper edge of the Message area. This will happen if the Message area is shorter than the Object or if the cursor (entry point) was too high up in the Message area when the Object was imported.

### Entering a Single-Message Text

All text which is entered directly into the Message work area (not created as a text Object and imported) is a single-Message text. The term ‘single-Message’ is used because the Objects are only used in one Message whereas other, imported Objects can be used in many Messages.

1. Position the cursor where you want to enter text.
2. Enter the text and then press **Enter** to end the field.

The characters are contained in a field which can be selected for editing or moving. See “Selecting a Field for Editing” on page 37.

Up to 100 characters can be entered into a single field. If 100 characters has been reached press Done, to end the field, and start a new field by entering more characters.

### Drawing a Single-Message Line

**File Message Line**

For drawing vertical or horizontal lines in the Message work area.

1. Position the cursor at the leftmost/lowest point of the line which shall be drawn and press Line.
2. Draw the line and change the line’s thickness using the arrow keys.
   - To draw in larger steps, press the Ctrl key while pressing one of the arrow keys.
   - To change the position of the line press Shift or Shift + Ctrl together with one of the arrow keys.
3. To change the line’s overlap press Field Attr. See “Setting the Field Attributes” on page 36.
4. Press Done to continue or Cancel to leave Line without drawing the line.

### Drawing a Single-Message Rectangle

**File Message Rectangle**

For drawing rectangles in the Message work area.

1. Position the cursor at the leftmost/lowest point of the rectangle which shall be drawn and press Rectangle.
2. Draw the rectangle using the arrow keys.
   - To draw in larger steps, press the Ctrl key while pressing one of the arrow keys.
   - To change the position of the rectangle press Shift together with one of the arrow keys.
3. To change the rectangle’s edge thickness, press Thicker or Thinner.
4. To change the rectangle’s overlap press Field Attr. See “Setting the Field Attributes” on page 36.
5. Press Done to accept the rectangle and leave the Rectangle function or Cancel to leave Rectangle without drawing the rectangle.

### Editing an Object in a Message

**File Message Edit**

- While moving an Object (imported Text, Barcode, Graphic, Counter, Clock or Time-
code), only the Object’s outline (border) is displayed.

- A single-Message rectangle or line is always shown completely and covers the underlying field(s) when selected for editing.

If the Message extends past the screen boundaries the user can view other parts of the Message by pressing:

- move right in Message area
- move left in Message area

If any other key is pressed, the view returns to the original part of the work area.

Move the cursor to the far left of the Message area.

Move the cursor rightwards to the start or end of the next field (positions 2 to 4 in the example below).

Move cursor leftwards to the start or end of the previous field (positions 4 to 1 in the example below).

deletes the entire field.

**Test-Printing a Message**

File Message Test Print

After pressing Test Print and as long as “Ready to print” is shown in the display, the control unit will print this Message each time a printout is activated.

**Saving a Message**

File Message Save

Press Save to give the Message a name and store it in memory.

If the Message is given a 3 digit name it can be selected for printout using the buttons on the control unit’s control panel. This is also necessary if Master Functions shall be used. See “Master Functions” on page 45.

**Editing a Message**

File Message Font, Field Attr or Edit

A Message can be made to look differently using one or both of the following methods:

**Message setup**

For setting the appearance of all fields which shall be added to the Message. Note that, only fields created after the setting change will be affected.
Editing individual fields
For making changes to the appearance and position of individual fields in the Message. This method is used to give one or more fields different settings as compared to the Message setup. Note that the field must be selected before any changes can be made. See “Selecting a Field for Editing” on page 37.

Editing a Text
File > Message Edit
Only the contents of single-Message texts can be edited directly in the Message. To change the contents of an imported Object see “Creating and Deleting Objects” on page 19.
1. Select the field (see “Selecting a Field for Editing” on page 37) and press Edit.
2. Make the changes to the text. See “Editing Text fields” on page 11.
3. Press Done.

Repositioning a Field
File > Message Edit
Any field in a Message can be moved.
1. Select the field (see “Selecting a Field for Editing” on page 37) and press Edit.
2. Use the arrow keys to move the field.
3. Press Done.

Editing a Line or Rectangle
File > Message Edit
Only single-Message lines or rectangles can be edited directly in the Message. To change the contents of an imported Object see “Creating and Deleting Objects” on page 19.
1. Select the field (see “Selecting a Field for Editing” on page 37) and press Edit.
2. Use the keyboard keys to make the change.
3. Press Done.

Changing the Font and Character Separation
File > Message Edit > Font Advanced
Skip step 1 and go directly to step 2 if this is a Message setup (setting the font and character separation for future fields in this Message).
1. To edit an individual field, select the field (see “Selecting a Field for Editing” on page 37) and press Edit.
2. Press Font and select a new font from the list.
3. Press Advanced. The character separation function is used to change the spread of the characters to be printed.
   - Amount can not be set to a negative value. This means that characters can not over-
At all settings the character boundary (shown below with a dashed box) determines how close the characters can come together. The width of the boundary box can differ from font to font.

One of three settings can be chosen.

**No character separation**  Constant or Variable set to 0 (zero): The characters are as close together as the selected font’s boundary box allows.

**Constant set to more than 0 (zero):** This setting adds an equal amount of space (dots) between all boundary box pairs.

**Variable set to more than 0 (zero):** Here space (dots) is added to the shortest distance between the characters themselves, and not the boundary boxes.

This setting takes into consideration the shape of each character and therefore avoids the mono-spaced effect given by the other settings. Note, however, that (as is always the case) the characters can not come closer to each other than their boundary boxes allow.

Press Ok.

Press Done to leave Edit mode. This step is only necessary when editing an individual field.

Setting the Field Attributes

File -> Message Field Attr or
File -> Message Edit Field Attr

The Field Attributes function manipulates dots to change the appearance of fields in a Message.

- The screen can not show overlapping dots.
- Barcodes and single-Message lines and rectangles are not affected by the Dark, Light and Inverse settings.

Skip step 1 and go directly to step 2 if this is a Message setup (setting the field attributes for future fields in this Message).

1. To edit an individual field, select the field (see “Selecting a Field for Editing” on page 37) and press Edit.
2. Press Field Attr.
3. Make your selections using the arrow keys and the single dot key ( ).
4. Press .
5. Press Done to leave Edit mode. This step is only necessary when editing an individual field.

Deleting a Field

File -> Message Edit Delete

Any field in a Message can be deleted.

1. Select the field (see “Selecting a Field for Editing” on page 37) and press Edit.
2. Press Delete and then Yes to confirm.
The field will now be removed from the Message. The source Object is not affected.

**Selecting a Field for Editing**

To be able to make changes to the appearance of a field you must first select the field. The following describes how this is done.

- Any change to be made to the actual contents of an imported Object, must be made at the Object source. See “Creating and Deleting Objects” on page 19.
- The contents of a single-Message text, line or rectangle (entered **directly** into the Message) is edited in the Message itself.

1. With the Message open, select a field by positioning the cursor over the field’s bottom line of dots.

   To select a graphic, rectangle, line or barcode, use the arrow keys to position the top or bottom left-hand point of the cursor on the bottom line of the field.

   ![Cursor correctly positioned over the field's bottom line](image)

   Position the top or bottom left-hand point of the cursor along this line to select the graphic

2. Press Edit and make the necessary changes. See “Editing a Message” on page 34, for more information.

**Changing the Print Attributes**

**Fik Message Print Attr**

The print attributes control the way the control unit prints the current Message. Note that the changes made here are not seen until the Message is printed.

These settings are for individual Messages only. For controlling how all new Messages look when created, see “Changing Message Setup” on page 53.

**Changing the Dot Size**

**Fik Message Print Attr Dot Size**

For changing the Dot Size setting for the current Message.

- The Dot Size setting is used for changing the amount of time, in micro seconds, that the print head nozzles are open and producing dots. The longer the time, the larger the dot.
For S.C.I. F.I. 3400: A good starting point is 220.
For DOD 8400: A good starting point is 600.

Changing the Spacing
File | Message | Print Attr | Spacing
For changing the column spacing for the current Message.

The Spacing setting is used for changing the distance between dots. The larger the value, the larger the horizontal space between dots.
The spacing setting is shown in two different ways, depending on if the print head is at full height (untitled) or is at reduced height (tilted).

Untilted print heads
Select Spacing and enter the required distance.

Tilted print heads
Select Spacing and select one of the settings.

In installations with tilted print heads (see “Height” on page 49), a number of settings will be made available for you to choose between. For each setting the column furthest to the right will show how much (or little) the printout will deviate from the vertical (lean or tilt).

Positioning Printout on Print Target (Margin)
File | Message | Print Attr | Margin
The printout activator lets the printer know when the leading edge of the print target is in front of the print head. If the Message shall be printed immediately, then nothing needs to be done. But if this Message shall be printed further along the print target then the following factors must be taken into consideration.

1 Enter the desired Margin setting for this Message.
Check the table below to see if the Target Length needs to be set.

<table>
<thead>
<tr>
<th>Desired Margin position</th>
<th>Print Direction</th>
<th>Target Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC</td>
<td>Left</td>
<td>Not necessary</td>
</tr>
<tr>
<td>ABC</td>
<td>Right</td>
<td>Must be set</td>
</tr>
<tr>
<td>ABC</td>
<td>Left</td>
<td>Not necessary</td>
</tr>
<tr>
<td>ABC</td>
<td>Right</td>
<td>Must be switched off</td>
</tr>
</tbody>
</table>

(a) This parameter does not need to be set for this particular setup. However, the parameter can be set if this Message is intended for use in another control unit which has the opposite print direction setting.

Changing the Target Length

Enter the distance from the print target's leading edge to its trailing edge for the current Message.

Off - Instructs the control unit to insert the margin from the right edge of the target. The Margin parameter is automatically set to Right when Target Length is switched off and the print direction is set to Right.

More than zero - Tells the control unit to insert the margin from the left edge of the target according to the value given here and the print direction is set to Right.
Printing a Message

For selecting a Message for printout.

Selecting a Message for Printout

Print
See also “Master Functions” on page 45 and “Using the Control Panel” on page 41.

1 Press Print.

Pressing Stop Print will stop the current printout and clear the currently selected Message.

2 Select a Message and then press Ok.

• If the selected Message has more dots in height than the number of print head nozzles available for printing, a function will now appear allowing the user to decide what part of the Message shall be printed. See “Adapting a Printout to a Print Head” on page 41.

If the selected Message can be printed with the connected print head/s, the Message will now be shown.

If necessary, use the and keys to preview parts of the Message outside of the screen area.

In installations using multiple print heads which are tilted to reduce the print height, an invisible part will be included at the end of some Messages. The length of this part is shown within brackets. Consequently the two numbers added together (in this case 79+63) equals the full length of the Message. This information must be taken into consideration when repeating the printout, see “Repeating Printout (Mark Gap)” on page 58.

3 Press Ok.

The Message that has been selected for printout is now shown in the display.

The Message will be printed the next time a printout is activated.
Adapting a Printout to a Print Head

Print

This function will appear if the Message selected for printout has more dots in height than the number of print head nozzles available for printing. If this happens, this function is used to let the control unit know what portion of the Message the print head shall print.

In the example below a 32 dot high Message has been selected for printout but it is only possible to print a group of 16 dots with the print head/s connected. This screen may be different for you depending on the print heads connected and how they have been set up to share the printout.

The area with the shaded background represents the portion of the Message which will not be printed and the area with the other part shows the portion which will be printed.

When Ok has been pressed the actual Message will be shown in the same way. Pressing Ok again will select the Message for printout.

Using the Control Panel

Master Functions may be active on your network of printers. If so, selecting a Message for printout or stopping printout from printer 01's control panel will have the same affect on all units in the network. See “Master Functions” on page 45 for more information.

S.C.I. F.I. 3400 and DOD•8400

At Start-up

When the control unit is switched on, the display will first show the program version number for about 2 seconds. After this the control unit carries out a number of memory and hardware tests. If no faults are found, the control unit will start correctly after a total of about 4 seconds^a.

See also “Error Codes and Messages” on page 64.

(a) The keyboard takes a further 20 to 25 seconds to start.
**Selecting a Message for Printout**

If Master Functions has been activated, selecting a Message for printout at unit 01 (via the control panel) will select the Message with the same name at all networked units. See “Master Functions” on page 45 for more information.

Only Messages with 3 digit names can be selected here
1. Press C to select (highlight) one of the digits in the display window.
2. Press A to change the selected digit.
3. Repeat steps 1 and 2 to change other digits.
4. Press C so that none of the digits in the display are selected.

**Clearing the Message (Stopping Printout)**

If Master Functions has been activated, stopping printout at unit 01 (via the control panel) will stop printout at all networked units. See “Master Functions” on page 45 for more information.

Press A and C together for about 1 second.
- If a Message is being printed when this is done the printout will be stopped.

**Flushing All Print Heads**

Be prepared with a container to catch the ink or cleaner fluid during flushing.
1. Press B and C together to switch between ink ◀ and cleaner fluid ◀.
2. Wait until the indicator lamps show that the change has been made.
3. Press B for at least 1 second.

---

**At Start-up**

When the control unit is switched on, the display will immediately show the program version number for about 2 seconds. After this the control unit carries out a number of memory and hardware tests. If no faults are found the control unit will start correctly after a total of about 4 seconds.

See also “Error Codes and Messages” on page 64.

**Selecting a Message for Printout**

If Master Functions has been activated, selecting a Message for printout at unit 01 (via the control panel) will select the Message with the same name at all networked units. See “Master Functions” on page 45 for more information.

Only Messages with 3 digit names can be selected here
1. Press C to select (highlight) one of the digits in the display window.

(a) The keyboard takes a further 20 to 25 seconds to start.
2 Press A to change the selected digit.
3 Repeat steps 1 and 2 to change other digits.
4 Press C until none of the digits in the display remain selected.

Clearing the Message (Stopping Printout)
Press D for about 1 second.
• If a Message is being printed when this is done the printout will be stopped.

If Master Functions has been activated, stopping printout at unit 01 (via the control panel) will stop printout at all networked units. See "Master Functions" on page 45 for more information.

flushing All Print Heads
All print heads connected to the selected CPU module will be flushed.
Be prepared with a container to catch the ink or cleaner fluid during flushing.
1 Press E to switch between ink <-> and cleaner fluid <->.
2 Wait until the indicator lamps show that the change has been made.
3 Press B for at least 1 second.

Confirming Errors
To give the user a chance to detect an error and make a note of it, some errors (see "Error Codes and Messages" on page 64) must be confirmed by the user in the following way:

1 When the error code is shown in the control unit display, press button A. This selects YES which is shown in the display.
2 Press button B to accept the selection and start the control unit.
• As some errors are closely related several codes may be displayed after each other.
• For some errors the number of files lost is displayed after button B has been pressed. Press button A and then B again to confirm.
• Pressing button C, at step 1, will cause NO to be shown in the display. This selection is intended for use with future functions and can therefore not be accepted with button B. Press button A instead.
Network Functions

See also “Master Functions” on page 45.

Operating One Control Unit From Another

The Network Unit function is used to operate one control unit in the network from another.

1 With the keyboard$^a$ connected to any control unit in the network, press Network Unit.
2 Select a remote control unit and press $^b$.
3 The control unit is now electronically connected to the selected control unit and its name is shown on the screen.

All actions carried out on the keyboard or PC will affect that control unit only.

4 To stop operating the remote control unit press Network Unit and select the local control unit.
   • Unplugging the keyboard will terminate network communication.
   • All unsaved Messages, etc. will be lost when changing the connection.

Copying Files To Other Control Units

File Network Copy

This Tool is used for copying Messages and Objects (files) to other control units in the network.

If you shall copy a Message to another unit, don’t forget to also copy the Objects which are used in the Message.

See also the Technical Manual for information on replacing one control unit with another.

1 Make sure that the name of the control unit that shall transmit the data, is displayed in the bottom, right hand corner of the screen. If necessary, connect to the correct unit using the Network Unit Tool. See “Operating One Control Unit From Another” on page 44.
2 Press Network Copy.

3 Select the unit which shall receive the data or select AllNodes if all units in the network shall receive the data.

4 Select the type of information which shall be copied.

5 Select a specific file or press Copy All to copy all files of this type.

   If a single file was selected, Show can now be pressed to preview the contents of the selection. If necessary, use the  and  keys to preview information outside of the screen area.

6 Press Ok (or Yes if all files shall be copied).

   The screen will now show the number of the control unit receiving the data (one after the other if AllNodes was selected) and the name of the file being copied.

   If Copy All was pressed, each file name will be shown, as it is copied, together with a number showing the order in which it was copied (1 for first, 2 for second, etc.).

7 Leave the Network Copy Tool.

Master Functions

Master functions are those which are automatically carried out at networked units as a direct result of the same functions being carried out at control unit 01. An example of such a function is Master Printout Stop where stopping printout at control unit 01 will stop printout at all networked units.

Master

Networked units

Unit 01
Unit 02 to 63
Unit 64

Master Functions must be activated before any of the functions, described here, can be used. How this is done is explained in the Technical Manual.

When Master Functions is activated, the three LED dots in the control panel display will blink while a Message is being selected.

Selecting a Message for Printout

When Master Functions is activated, selecting a Message for printout at control unit 01’s control panel will automatically cause the Message with the same name to be selected for printout at all networked control units. Note that the actual contents of the Messages do not need to be the same, only their names.

This function only applies to Messages with names consisting of 3 digits.

To select a Message for printout at an individual unit, do one of the following:

- At unit 01 - Select the Message at unit 01’s keyboard
- At a networked unit - Select the Message at the individual unit’s control panel or keyboard.

(a) This also applies when the same Message is reselected.
An easy way to produce the same Message in all units is to create a Message and copy it and its Objects using the AllNodes function. For more information see “Copying Files To Other Control Units” on page 44.

The following could happen when selecting a Message for printout:

<table>
<thead>
<tr>
<th>If this situation arises</th>
<th>This will happen</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Message, selected at unit 01’s control panel, does not exist in unit 01.</td>
<td>The control panel display shows the previously selected Message. This is not considered as a new selection so nothing happens at the networked units.</td>
</tr>
<tr>
<td>The Message, selected at unit 01’s control panel, does not exist in a networked unit.</td>
<td>No Message is selected and printout is stopped at that networked unit.</td>
</tr>
</tbody>
</table>

Clearing the Message (Stopping Printout)

When Master Functions is activated, stopping printout at control unit 01’s control panel will automatically cause printout to be stopped at all networked control units. Note that the actual contents of the Messages do not need to be the same, only their names.

- Stopping printout at a networked unit (via the control panel or keyboard) will only stop printout at that particular control unit. This is also the case if printout is stopped from control unit 01’s keyboard.

Synchronising Clock Objects

When Master Functions is activated, each unit’s master clock is synchronised with the master clock in unit 01. This is done automatically each time unit 01 is switched on.
Display Settings

These settings are stored in the keyboard.

Audible Keys and Screen Saver

The following can be set to adapt the keyboard to your personal preferences:

**Skip Audible Keys**
When the Skip Audible Keys function is set to on (1), the keyboard will not emit a short beep to confirm that a key has been pressed.

A long beep will sound if a key is pressed at the wrong time or in the wrong situation. This function can not be switched off.

**Skip Screen Saver**
After 5 minutes of inactivity (no keys pressed during this time) the Screen Saver will be activated and the screen will be dimmed. Pressing any key\(^a\) will return the screen to its original state.

Changing Settings

1. Switch the control unit on.
2. Press \(`` and \(Esc`` \) together.
   This enters the setup menu for the keyboard. Pressing \(Esc`` \) at any time will exit the menu without any changes being made.
3. Use the up and down arrow keys to select Skip Audible Keys or Screen Saver.
   - **Skip Audible Keys**
     Enter a 1 (one) to turn the Audible Keys function off.
     Enter a 0 (zero) to turn the Audible Keys function on. This is the default setting.
   - **Skip Screen Saver**
     Enter a 1 (one) to turn the Screen Saver function off. This setting will only apply until the control unit is switched off or the Display Settings screen is re-entered.
     Enter a 0 (zero) to turn the Screen Saver function on. This is the default setting.
4. Press \(Enter`` \) to accept and store any changes made.

Setting the Display Contrast

1. Switch the control unit on.
2. Press and release \(Esc`` \), or hold \(Esc`` \) and press and release \(Esc`` \), to cycle through the contrast settings until the desired setting is reached.
   To return to the default contrast setting press \(`` and \(Esc`` \) together.

Setting the Display Language and Measurement Units

**Installation Language**
These settings are stored in the control unit.

1. Switch the control unit on.
2. Select Installation and then Language and press the \(Enter`` \) key.
3. Using the arrow keys, select the a language and press the \(Enter`` \) key.
4. Using the arrow keys, select Units and then a measurement system\(^b\) and press the \(Enter`` \) key.

---

\(a\) The key’s actual function will not be performed.

\(b\) The key’s actual function will not be performed.
5 Select the Ok button by pressing the key and then press the  key. The new settings will now start to apply.

Changing Installation Setup

The installation setup parameters are used to adapt the control unit to the mechanical aspects of the installation.

Advanced Settings

Viewing Setup

Installation Advanced

The first Advanced Tool screen shows an overview of the parameters and their current settings. See below for more information on each parameter.

(b) The METRIC setting will give somewhat better accuracy as it is the control unit's internal measurement system. The IMPERIAL setting may suffer from some rounding-off errors although this will not normally be noticed.
**Trigger**

Installation † Advanced

For setting the printout activator (trigger) parameters.

1. At **Trigger**, select a printout activator source:
   - **Internal**: The print head's built-in activator shall be used.
   - **External**: The activator connected to the control unit shall be used.
   - **Network**: The activator connected to another control unit in the network shall be used. Select the control unit at **Network Unit**.

2. At **Distance**, enter the distance from the external print activator to the print head's built-in activator.

   If the print head does not have a built-in activator, enter the distance from the external activator to the print head's topmost nozzle.

---

**Encoder**

Installation † Advanced

For setting the speed encoder parameters.

1. At **Encoder**, select an encoder source:
   - **None**: A speed encoder shall not be used. See below for setting the Speed.
   - **External**: The speed encoder connected to the control unit shall be used. See below for setting the pulse rate for the speed encoder.
   - **Network**: The speed encoder connected to another control unit in the network shall be used. Select the control unit at **Network Unit**. See below for setting the pulse rate for the speed encoder.

2. Set the **Pulse Rate** or **Speed**. Note that these settings affect the horizontal spacing of dots at printout.
   - **Pulse Rate**: The number of pulses per measurement unit (metre or foot) emitted by the encoder.
   - **Speed**: The speed of the print target when it passes the print head.

---

**Height**

Installation † Advanced

This function is used to reduce the height of the whole print area by tilting the print head.

---

(a) This selection only appears if the print head connected to the control unit has a built-in trigger.
(b) Distance will only be set if **Trigger** has been set to **External** or **Network**.
The Height function is dependant on how the Encoder parameters are set. It is therefore important that Encoder is set first. See “Encoder” on page 49.

To reduce the print height all you need to do is select the new height and the program will let you know how much to tilt the print heada. The program will correct the printout so that it is upright.

1. Print Head un-tilted and printout at full height.
2. Print Head tilted but printout not corrected.
3. Print Head tilted and printout corrected.

The new height is entered as a percentage of the maximum print height (print head not tilted). When this is done the Reduced Print Height screen will show the following information:

- A. Height reduction value - Either enter a value directly or select the percentage you want the print height reduced to.

- B. Print head tilt angle - This is the angle to which you should tilt the print head to achieve the desired print height reduction. The program will automatically correct the printout so that it is not tilted. Note that the print head is always tilted against the print direction.

- C. Maximum print height (H) - This is the resulting maximum height of the printout. See the diagram above.

- D. Row spacing (h) - This is the resulting vertical distance between printed dots. See the diagram above.

- E. Column spacing list - Here are up to seven different settings for the resulting horizontal distance between printed dots. See the diagram above. One or more of these settings will be made available during Message setup (see “Spacing” on page 54) and one of those will be used when creating a Message (see “Changing the Spacing” on page 38).

- F. Deviation list - Zero percent (0%) deviation means that the program will be able to produce a printout without slant, as long as:
  - the corresponding column spacing is chosen for the message to be printed (see “Changing the Spacing” on page 38).

The and keys are used to select settings which are suited to the speed encoder being used. Each press will step to a setting giving at least one choice of column spacing (E) which, when used, will produce a printout without slant (0%). For some settings, a tilde (~) character (G) will appear to show that the calculation of the height reduction value suffers from some inaccuracy due to the speed encoder characteristics. Try to avoid using these settings.

Note that changing the Height value will change the default Spacing value for new Messages (see “Spacing” on page 54). Although the program attempts to keep this change as small as possible, in some cases this is impossible and the default Spacing value will be replaced with the Spacing value from the top of the Column spacing list (E).

(a) 3400 only - If more than one print head is connected to the unit then all print heads must be tilted the same amount and in the same direction.
- the print head has been tilted to the specified angle (see B above).

The amount a printout slants depends on the number of pulses per distance unit received from the speed encoder (if used). The more pulses received the easier it will be to produce a printout without slant.

To get the correct value, multiply the slant percentage value with its position in the list, e.g. multiply with one (1) if the slant percentage value is at the top of the list, or with three (3) if it is the third from the top, etc.

1. Enter the desired height as a percentage of the maximum print height. You may need to remove the current setting first using the back-space or delete key. Use the formula below to work out the percentage for your print head.

\[
\text{Desired height (mm)} = \frac{\text{Number of nozzles} \times \text{Nozzle separation (mm)}}{100}
\]

Example:

- Desired HEIGHT (mm)
  - Number of nozzles (16) \times \text{Nozzle separation (4mm)}
  - \(50 / 64 \times 100 = 78\) — Enter 78

2. Tilt\(^\text{a}\) (rotate) the print head according to the angle shown on the screen (B).

Remember to reposition the print activator accordingly.

3. Press Ok.

**Print Direction**

Set which direction the print target shall pass the print head.

(a) Tilting the head will change the distance between the external print activator (if used) and the print head. The Distance setting must be changed accordingly.
The table below shows the relationship between the Margin, Print Direction and Target Length settings:

<table>
<thead>
<tr>
<th>Desired Margin position</th>
<th>Print Direction</th>
<th>Target Length</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left</td>
<td></td>
<td>Not applicable</td>
</tr>
<tr>
<td>ABC</td>
<td>Right</td>
<td></td>
<td>Must be set</td>
</tr>
<tr>
<td></td>
<td>Left</td>
<td></td>
<td>Not applicable</td>
</tr>
<tr>
<td>ABC</td>
<td>Right</td>
<td></td>
<td>Must be switched off</td>
</tr>
</tbody>
</table>

See the following for related information:

- “Margin” on page 53
- “Target Length” on page 54

**Printable Rows**

Installation & Advanced

Also referred to as Message Mapping, this function is used to let the printer know which part of a 32 dot high Message shall be printed.

As the maximum height for a single Message is 32 dots, the print heads connected to this unit must have a combined total of at least, 32 nozzles. If the print heads have less than 32 nozzles then only a part of the Message can be printed. The Printable Rows Tool is used to inform the control unit which part of the Message the print heads shall print.
Changing Default Message Settings

This group of functions, in the Parameters Tool, is used for determining the setup for new Messages. This means that Messages already created will not be affected by changes made to these settings.

Dot Size

Installation Parameters

For changing the amount of time the print head nozzles are open and producing dots.

- Low setting
- High setting

Recommended settings

For S.C.I. F.I. 3400: A good starting point is 220.
For DOD-8400: A good starting point is 600.

This setting applies to all Messages that are created after this parameter is set. To change this setting for each separate Message, see “Changing the Dot Size” on page 37.

Margin

Installation Parameters

The printout activator lets the printer know when the leading edge of the print target is in front of the print head. If the message shall be printed immediately, then nothing needs to be done. But if Messages shall be printed further along the print target then Margin must be set.

This setting applies to all Messages that are created after this parameter is set. To change this setting for each separate Message, see “Positioning Printout on Print Target (Margin)” on page 38.

The table below shows the relationship between the Margin, Print Direction and Target Length settings:

<table>
<thead>
<tr>
<th>Desired Margin position</th>
<th>Print Direction</th>
<th>Target Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Left</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Right</td>
<td>Right</td>
<td>Must be set</td>
</tr>
<tr>
<td>Left</td>
<td>Left</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Right</td>
<td>Right</td>
<td>Must be switched off</td>
</tr>
</tbody>
</table>

See the following for related information:

- “Print Direction” on page 51
- “Target Length” on page 54
Spacing

Installation ➤ Parameters
For changing the distance between columns of dots.

This setting applies to all Messages that are created after this parameter is set. To change this setting for each separate message, see “Changing the Spacing” on page 38.

When the Print Height Has Been Reduced
For:
• Making Spacing settings available for selection when creating a Message.
• Selecting the default Spacing setting for new Messages.

1. Select each Spacing value in turn and press the key to switch between the following settings:
   • Percentage (%) value shown - The setting is enabled and available for selection when creating a Message.
   • --- shown - The setting is disabled and will not be available for selection when creating a Message.

2. Select the setting that shall be the default Spacing setting for new Messages and press .

When the Print Height Has Not Been Reduced
For changing the default Spacing setting for all new Messages. If no other setting is entered in a Message, this setting will be used.

Target Length

Installation ➤ Parameters
For changing the print target’s length setting.
This setting applies to all Messages that are created after this parameter is set. To change this setting for each separate Message, see “Changing the Target Length” on page 39.

(a) The current default setting can not be disabled. A new default setting must be selected first.
The program uses the Target Length value to calculate where on the print target the printout shall start so that the Margin distance is correct. This is only necessary when the Margin is calculated from the print target’s trailing edge.

The table below shows the relationship between the Margin, Print Direction and Target Length settings:

<table>
<thead>
<tr>
<th>Desired Margin position</th>
<th>Print Direction</th>
<th>Target Length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>Right</td>
<td>Must be set</td>
</tr>
<tr>
<td>Must be switched off</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See the following for related information:
- “Print Direction” on page 51
- “Margin” on page 53
Changing Printout Setup

This group of functions, in the Parameters Tool, is used for determining how messages will look at printout.

The functions described in this chapter are global default functions. This means that changes made to these settings have an immediate effect on printer behaviour.

Ink Type

Installation ☛ Parameters

When the print head has not printed for a while the first dots of the next printout can appear weak or be missing. If this is often the case it may help to change the Ink Type setting.

- A low value will make a small adjustment.
- A high value will make a large adjustment.

Note that if the Ink Type parameter is set too high, the leading dots will appear stronger than the following dots.

Printout Limit Functions

Installation ☛ Parameters

These parameters are used to set the repeat print function and to stop printing when certain conditions arise.

Stopping Printout at End of Target (Terminate)

The Terminate function is used to stop the ongoing printout at the end of the print target.

This can be useful if, for example, a print target which is shorter than the selected Message passes by the print head. In such a case the printout will be terminated at the end of the target and a new printout will be started when the next target passes by.

Example: Print text “12345”

The printout activator is used to signal when the end of the print target has passed by.
CHANGING PRINTOUT SETUP

Repeating Printout (Mark Gap)
Enter the distance between repeated messages.
Note that in some cases the message may include “white space”, such as space characters, etc., at the start or end of a message. If so this will increase the distance between repeated messages.
Up to 20000 mm (787 in) may be entered.

When Mark Gap has been set to a value, and the Max Mark function has been set to Off, the control unit will continue printing the same message again and again as long as the print activator detects an object.

Limiting Number of Printouts (Max Mark)
Enter the maximum number of printouts per print activation.
• The printout will only be repeated if Mark Gap is set to On.
• For Messages being printed, the new setting will come into effect at the next printout activation.

In the example below this function has been set to 2.

Limiting Number of Printout Activations (Max Trig)

Installation Parameters
Enter the number of triggers (printout activations) before the control unit shall stop printing. Set to Off for an unlimited number of printouts.

Note that only actual printout activations are counted, a print head flush will, therefore, not affect the count-down.
• For Messages being printed, the new setting will come into effect at the next printout activation.

In the example below the Max Trig function has been set to 4.

After the last printout the control unit will not print again until one of the following occurs:
• The same, or a new, message is selected for printout.
• The Max Trig setting is changed or switched off.
Combining limit functions

Example: print text “ABC”

<table>
<thead>
<tr>
<th>Max</th>
<th>Trig</th>
<th>Mark</th>
<th>Gap</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>2</td>
<td>10mm</td>
<td></td>
</tr>
</tbody>
</table>

ABC ABC

2

ABC

2

ABC ABC

ABC ABC

ABC ABC

ABC ABC

ABC ABC

1 When the Mark Gap function is set to Off, the Max Mark setting will not apply.

Calendar functions

Setting the Day & Month names

Installation ➔ Parameters

Each day and month can be given a new name consisting of up to 18 characters. These names are used in Clock Objects.

Setting the Date and Time

Installation ➔ Parameters

For setting the date and time for all messages containing a date or time.

This function is used to set the control unit’s internal (master) clock. Note that all clock objects are set relative to this clock. If this clock is set incorrectly all other dates and times will be equally incorrect.

This clock is also referred to as “true time”.

1 Set the parameters for summer and winter time change over and press Next.

Max Max Mark

2 2 10mm

ABC ABC

ABC ABC

ABC ABC

ABC ABC

ABC ABC

ABC ABC

ABC ABC

ABC ABC

1 When the Mark Gap function is set to Off, the Max Mark setting will not apply.

Enter the date and time for the +1 hour change over at the Start of summertime and the date and time for the -1 hour return at the End of summertime.

Month: Enter the number of the month when the daylight saving time period shall start or end.

Earliest Day: Enter the number of the earliest day in the month when the daylight saving time period shall start or end.

Latest Day: Set automatically to seven days past the Earliest Day setting.

Hour: Enter the hour of the day when the daylight saving time period shall start or end.

Weekday: Enter the number of the weekday when the daylight saving time period shall start or end.

For example, if the daylight saving time period always starts on a Sunday, enter 7.
2 Set the date and time for the master clock and press Ok.

The hour must be in 24 hour format. For example, 2 o'clock in the afternoon is 14.
Appendices

This equipment complies with the EMC Rules for a Class A (industrial environment) computing device. Operation of this equipment in a residential area may cause unacceptable interference to radio and TV reception.

Technical Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print specification:</td>
<td>Positioning of Objects in Message area unrestricted. Maximum 50 objects per Message. Maximum work area: 2560x32 dots. Maximum message size: 12800x32 dots</td>
</tr>
<tr>
<td>Fonts:</td>
<td>Dependant on print head type used. See the Operator Manual for more information.</td>
</tr>
<tr>
<td>Target speed:</td>
<td>Dependant on print head type used. Up to 4 m/s (790 ft/min)</td>
</tr>
<tr>
<td>RAM:</td>
<td>Dynamic memory giving up to 400 characters per message line and up to 200 messages. Maximum 200 kB</td>
</tr>
<tr>
<td>Power requirements:</td>
<td>3400: 100-240V AC; 1.3A; 50-60Hz</td>
</tr>
<tr>
<td></td>
<td>8400: 115V AC; 2.0A; 50-60Hz</td>
</tr>
<tr>
<td></td>
<td>230V AC; 1.2A; 50-60Hz</td>
</tr>
<tr>
<td></td>
<td>R44: 115V AC; 4x2.4A; 50-60Hz</td>
</tr>
<tr>
<td></td>
<td>230V AC; 4x2.4A; 50-60Hz</td>
</tr>
<tr>
<td>Ambient temperature/humidity:</td>
<td>±0 to +45C (+32 to +113F) - 10 to 95%, non condensing</td>
</tr>
<tr>
<td>Safety norms:</td>
<td>UL-1950, EN 60950, CSA, CE</td>
</tr>
<tr>
<td>IP classification (control unit):</td>
<td>IP42 (IP54 optional)</td>
</tr>
<tr>
<td>Keyboard display:</td>
<td>Graphic, 1/4 VGA, 320x240 pixels, monochrome, backlit with auto screensaver</td>
</tr>
<tr>
<td>Communication:</td>
<td>Serial interface: RS-232, 7/8 bit, 1/2 stop bits, baudrate 1200 - 115200, Xon/Xoff selectable, CTS/RTS required.</td>
</tr>
<tr>
<td></td>
<td>Character encoding: ISO 8859-1, ISO 8859-2, Unicode (UTF-8 transformations format)</td>
</tr>
<tr>
<td></td>
<td>General input and output bits: 4 and 3 respectively (all bits programmable using MATTCOM commands)</td>
</tr>
</tbody>
</table>

Maintenance

To ensure problem free operation it is a good idea to look over your ink jet printer system as often as possible.

Get into the habit of asking yourself the following questions:

- Does the printout look Ok?
- Is there enough ink/cleaner fluid?
- Do the print head nozzles need cleaning/flushing?
- Do the cables and tubing look Ok?

For maintenance instructions pertaining to a specific print head or ink supply unit, please see the documentation received with the applicable device.

Using the Flush Function

The control panel buttons are shown under “Using the Control Panel” on page 41.

The flush button on the control panel, is pressed to flush the print head nozzles before and after a longer print stop or if the nozzles have become blocked.

A flush can be normal or long depending on when the flush button is pressed.

Below are the approximate flush times in seconds.

<table>
<thead>
<tr>
<th>Control Unit</th>
<th>S.C.I. F.I. 3400</th>
<th>DOD•8400</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Head</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3000-7v</td>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>3000-16v</td>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>8000-16v</td>
<td>8</td>
<td>11</td>
</tr>
<tr>
<td>8000-32v</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>Long Flush</td>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>Normal Flush</td>
<td>1,5</td>
<td>1,5</td>
</tr>
</tbody>
</table>

(a) MATTCOM is used when controlling a printer using the RS-232 serial interface. See the MATTCOM instruction manual for more information.
Troubleshooting

See also “Error Codes and Messages” on page 64.
Check all cable connections before carrying out the following.
Contact a qualified service technician if the following does not help.

General Printout Faults

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unexpected printout</td>
<td>Master Functions activated</td>
<td>See “Master Functions” on page 45.</td>
</tr>
<tr>
<td>Message is being printed from another control unit or computer.</td>
<td>See “Operating One Control Unit From Another” on page 44.</td>
<td></td>
</tr>
<tr>
<td>No printout</td>
<td>No message selected.</td>
<td>Select a message.</td>
</tr>
<tr>
<td></td>
<td>Selected message empty.</td>
<td>Check message contents.</td>
</tr>
<tr>
<td></td>
<td>Printout not being activated</td>
<td>Check that printout activator is clean.</td>
</tr>
<tr>
<td></td>
<td>Printout limit reached.</td>
<td>Check position of activator.</td>
</tr>
<tr>
<td></td>
<td>Message is being printed by another control unit.</td>
<td>See “Operating One Control Unit From Another” on page 44.</td>
</tr>
<tr>
<td>Incorrect print attribute setting/s for this message.</td>
<td>See “Changing the Print Attributes” on page 37.</td>
<td></td>
</tr>
<tr>
<td>Cleaner-fluid selected instead of ink.</td>
<td>Select ink. See “Using the Control Panel” on page 41.</td>
<td></td>
</tr>
<tr>
<td>No ink / pressure.</td>
<td>Check the ink supply unit.</td>
<td></td>
</tr>
</tbody>
</table>

(Sheet 1 of 3)
### Barcode Printout Faults

It is important that a bar code is printed correctly so that the scanning equipment will be able to read and decode it. The following printouts show some of the more common bar code printout faults.

The examples shown here have been printed by a tilted 3000-16v print head.

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>White bars narrower than black bars</td>
<td>Spacing setting too low</td>
<td>Change Spacing setting</td>
</tr>
<tr>
<td>Black bars not solid enough</td>
<td>Spacing setting too high</td>
<td>Change Spacing setting or try setting Overlap to On</td>
</tr>
<tr>
<td>Black bars wider than white bars</td>
<td>Dot size setting too high</td>
<td>Change Dot Size setting</td>
</tr>
</tbody>
</table>

### Control Unit Faults

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>E01 in control unit display and control panel not working</td>
<td>No print head connected</td>
<td>Connect print head</td>
</tr>
<tr>
<td>LoU shown in control unit display</td>
<td>Low voltage to processor</td>
<td>LoU is shown each time the control unit is switched off and is not a fault. If LoU is shown during normal operation contact a service technician.</td>
</tr>
<tr>
<td>Display shows LoU and then segments light in sequence (3 times)</td>
<td>A temporary dip was detected in the voltage to the processor.</td>
<td>Contact service technician.</td>
</tr>
</tbody>
</table>

(a) This will make the code longer
### Keyboard Faults

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory failure.</td>
<td></td>
<td>Contact service technician.</td>
</tr>
<tr>
<td>Display contrast low.</td>
<td></td>
<td>Press the [D] key.</td>
</tr>
<tr>
<td>Screen light off.</td>
<td></td>
<td>Press any key.</td>
</tr>
<tr>
<td>Hardware failure or PROM fault.</td>
<td></td>
<td>Contact service technician.</td>
</tr>
<tr>
<td>RAM fault.</td>
<td></td>
<td>Contact service technician.</td>
</tr>
<tr>
<td>Keyboard software not compatible with control unit software (shown at power on).</td>
<td>The keyboard will not operate correctly.</td>
<td>Upgrade keyboard software.</td>
</tr>
<tr>
<td>Keyboard software obsolete. The keyboard will not operate correctly.</td>
<td></td>
<td>Upgrade keyboard software.</td>
</tr>
<tr>
<td>The control unit does not recognise the keyboard software. The keyboard will not operate correctly.</td>
<td>Try switching the power off and then on again. If this does not help upgrade keyboard software or change keyboard.</td>
<td></td>
</tr>
<tr>
<td>Only part of a command has been received.</td>
<td>Please make a note of the text on the screen and report it to Matthews Swedot.</td>
<td></td>
</tr>
</tbody>
</table>

### Error Codes and Messages

At start-up the control unit shows first the control unit’s software version number, in the control panel display, and then the control unit and keyboard carry out a number of memory and hardware tests.

The control unit also carries out tests during normal operation. If, after these tests are completed, a fault is found it is indicated in the form of error codes and messages.

- Error codes are always shown in the control panel display. Error messages are also displayed at the keyboard and terminal / PC (if connected).
- Messages shown at the serial interface are always in English.

### Control Panel Display

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trying to...&quot;</td>
<td>An incorrect command has been received.</td>
<td>Please make a note of the text on the screen and report it to Matthews Swedot.</td>
</tr>
</tbody>
</table>

### External 5V

- **CLEANER**
- **INK**
- **INTERNAL 5V**

### Serial Interface

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>No print head connected.</td>
<td>Check also hardware such as cables, etc.</td>
<td></td>
</tr>
</tbody>
</table>

(a) Software version number shown here.
E02
Network hardware does not respond to CPU. Contact service.

E03
Error code blinks 10 times. An internal configuration settings file is missing. Contact service.

E04
Can not read network chip (a symptom can be the lack of unit name in bottom, right corner of the keyboard display). Try restarting control unit. If fault remains contact service.

E05
Can not write to network chip. Contact service.

E06
Error code blinks ten times and then goes out - Return to default settings of control panel configuration. or...
Error code blinks ten times and then remains lit - Returning to default settings did not help! Serial port parameters invalid. Contact service.

E07 - E08
Required file(s) for networking function missing. Try restarting control unit. If fault remains contact service.

E09
Unit 01 could not broadcast its RTC or name of the selected message to the network (Master Functions activated).

E10
Could not activate the selected message for printout. The unit may be out of free memory or the message content is corrupt.

E11 - E23
These codes are for test purposes and are therefore only of interest to Matthews’ software engineers. If any of these codes should appear please report this to your dealer (or directly to Matthews) together with a description of the events leading up to when the code was displayed.

E60
SPACING LIMITED BY TOO LOW PRINT SPEED
Error code and message shown for 5 seconds. Target speed too low for selected message’s spacing setting. A lower spacing setting will be used when printing this message.

(Sheet 2 of 6)
E88  ERROR: CORRUPT FILE CONTENT
Missing or corrupt barcode or message file content was found.

E89  ERROR: OUT OF MEMORY  MEMORY FULL
Ran out of free memory for creating barcode or message files.
This error code should not be displayed if enough memory exists. If it is, please report this to your dealer (or directly to Matthews) together with a description of the events leading up to when the code was displayed.

E90  STACK OVERFLOW!!  WARNING, stack overflow occurred!!
During start-up.
Stack memory area is growing out of control. Most probable cause is MATTCOM program with more than 180 lines.
This error must be confirmed. See “Confirming Errors” on page 67.

E90  STACK OVERFLOW!!
Use PANEL buttons  WARNING, stack overflow occurred!!
Use buttons on PANEL to continue
During operation
Stack memory area is growing out of control. Most probable cause is MATTCOM program with more than 180 lines.
This error must be confirmed. See “Confirming Errors” on page 67.

E91  _ file[s] missing!!
_FILE[s] missing in directory!!
File table checksum error. The number of files (shown after the error code) in the display have been lost.
This error must be confirmed. See “Confirming Errors” on page 67.

E92  _ file[s] lost!!
WARNING, file[s] lost in memory!!
Stack overflow (E90) has resulted in the number of files shown in the display (after the error code) being lost.
This error must be confirmed. See “Confirming Errors” on page 67.

E93  Packing files!!
KEEP POWER ON, packing files!!
Memory low. After the user has confirmed this warning file packing will take place.
DO NOT SWITCH OFF DURING PACKING!
This error must be confirmed. See “Confirming Errors” on page 67.

E94  Out of memory.
You must kill files!!
Out of memory.
You must kill some files!!
Not enough memory to create necessary system files. After confirmation the user must delete some files and then restart the control unit.
This error must be confirmed. See “Confirming Errors” on page 67.

E97  —
During power on, multiple files were found to be making up the message currently selected for printout. Please report this to your dealer or directly to Matthews.

(Sheet 4 of 6)
Confirming Errors

To give the user a chance to detect an error and make a note of it, some errors (see “Error Codes and Messages” on page 64) must be confirmed by the user in the following way:

S.C.I. F.I. 3400 and DOD-8400 control panel

1. When the error code is shown in the control unit display, press button A. This selects YES which is shown in the display.

2. Press button B to accept the selection and start the control unit.
   • As some errors are closely related several codes may be displayed after each other.
   • For some errors the number of files lost is displayed after button B has been pressed. Press button A and then B again to confirm.
   • Pressing button C, at step 1, will cause NO to be shown in the display. This selection is intended for use with future functions and can therefore not be accepted with button B. Press button A instead.

R44 control panel

---

While the memory was being cleared the RAM was found to be defective. Contact service.

A major memory error has been detected and all files have been lost.
Service Functions

Time for Service

The control unit will signal when it is time for a routine service check.

When it is time for service, the keyboard will give an audible signal (beep) and display the following. This is done when returning from any Tool to the menu or, if in the menu, after 30 minutes of inactivity.

Barcode Information

All Barcodes

The following shows the parameters which may be set for each bar code type. For a description of each parameter see “Creating a Barcode Object” on page 22.

<table>
<thead>
<tr>
<th>Bar Code TYPE</th>
<th>ADJUST</th>
<th>FONT with Resulting HEIGHT in Dots</th>
</tr>
</thead>
<tbody>
<tr>
<td>All bar codes</td>
<td>YES or NO</td>
<td>NONE ........... 1 to 32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5x5 ................ 7 to 32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7x5 ................ 9 to 32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9x7 ................ 11 to 32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>14x10 ........... 16 to 32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16x10 ........... 18 to 32</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bar Code TYPE in Display</th>
<th>Full or Alternative Name</th>
<th>RATIO</th>
<th>Legal Character Set</th>
<th>Maximum DATA inputa</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/5</td>
<td>Code 2 of 5</td>
<td>1:2</td>
<td>0 (zero) to 9</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1:3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2/5I</td>
<td>Code 2 of 5 interleaved</td>
<td>1:2</td>
<td>0 (zero) to 9</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1:3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:6</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(Sheet 1 of 3)
<table>
<thead>
<tr>
<th>Bar Code Type in Display</th>
<th>Full or Alternative Name</th>
<th>RATIO</th>
<th>Legal Character Set</th>
<th>Maximum DATA Inputa</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODE-39</td>
<td>Code 3 of 9</td>
<td>1:2</td>
<td>0 (zero) to 9</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1:3</td>
<td>Upper-case A-Z, space, $, %, *, +, -, /</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DUN-14</td>
<td></td>
<td>1:2</td>
<td>0 (zero) to 9</td>
<td>13 (+)</td>
<td>Standard USA France</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1:3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DUN-16</td>
<td></td>
<td>1:2</td>
<td>0 (zero) to 9</td>
<td>15 (+)</td>
<td>Standard USA France</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1:3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DUN-W</td>
<td>DUN Weight code</td>
<td>1:2</td>
<td>0 (zero) to 9</td>
<td>5 (0+)</td>
<td>Standard USA France</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1:3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAN-8</td>
<td></td>
<td>1:2:3:4</td>
<td>0 (zero) to 9</td>
<td>7 (+)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4:6:8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAN-13</td>
<td></td>
<td>1:2:3:4</td>
<td>0 (zero) to 9</td>
<td>12 (+)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4:6:8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAN-128A</td>
<td>UCC-128A</td>
<td>1:2:3:4</td>
<td>See “Character Set For CODE-128” on page 70.</td>
<td>100 (+)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2:4:6:8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(a) Maximum number of characters entered by user. The symbols shown within brackets represent characters generated by the software and added to the code when imported to a message. + = Checksum, 0 = Leading zero. The DUN-W code can have zero to 4 leading zeros.

(Sheet 2 of 3)
## Character Set For CODE-128

See also “Entering Special Characters” on page 23.

<table>
<thead>
<tr>
<th>Value</th>
<th>Code Set A</th>
<th>Code Set B</th>
<th>Code Set C</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>SP</td>
<td>SP</td>
<td>00</td>
</tr>
<tr>
<td>1</td>
<td>!</td>
<td>!</td>
<td>01</td>
</tr>
<tr>
<td>2</td>
<td>&quot;</td>
<td>&quot;</td>
<td>02</td>
</tr>
<tr>
<td>3</td>
<td>#</td>
<td>#</td>
<td>03</td>
</tr>
<tr>
<td>4</td>
<td>$</td>
<td>$</td>
<td>04</td>
</tr>
<tr>
<td>5</td>
<td>%</td>
<td>%</td>
<td>05</td>
</tr>
<tr>
<td>6</td>
<td>&amp;</td>
<td>&amp;</td>
<td>06</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td>07</td>
</tr>
<tr>
<td>8</td>
<td>(</td>
<td>(</td>
<td>08</td>
</tr>
<tr>
<td>9</td>
<td>)</td>
<td>)</td>
<td>09</td>
</tr>
<tr>
<td>10</td>
<td>*</td>
<td>*</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>+</td>
<td>+</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>,</td>
<td>,</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>-</td>
<td>-</td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>/</td>
<td>/</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>0</td>
<td>0</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>1</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>2</td>
<td>2</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>3</td>
<td>3</td>
<td>19</td>
</tr>
<tr>
<td>20</td>
<td>4</td>
<td>4</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>5</td>
<td>5</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>6</td>
<td>6</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>7</td>
<td>7</td>
<td>23</td>
</tr>
<tr>
<td>24</td>
<td>8</td>
<td>8</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>9</td>
<td>9</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>:</td>
<td>:</td>
<td>26</td>
</tr>
</tbody>
</table>

(Sheet 1 of 4)
<table>
<thead>
<tr>
<th>Value</th>
<th>Code Set A</th>
<th>Code Set B</th>
<th>Code Set C</th>
</tr>
</thead>
<tbody>
<tr>
<td>56</td>
<td>X</td>
<td>X</td>
<td>56</td>
</tr>
<tr>
<td>57</td>
<td>Y</td>
<td>Y</td>
<td>57</td>
</tr>
<tr>
<td>58</td>
<td>Z</td>
<td>Z</td>
<td>58</td>
</tr>
<tr>
<td>59</td>
<td>[</td>
<td>[</td>
<td>59</td>
</tr>
<tr>
<td>60</td>
<td>\</td>
<td>\</td>
<td>60</td>
</tr>
<tr>
<td>61</td>
<td>]</td>
<td>]</td>
<td>61</td>
</tr>
<tr>
<td>62</td>
<td>^</td>
<td>^</td>
<td>62</td>
</tr>
<tr>
<td>63</td>
<td>_</td>
<td>_</td>
<td>63</td>
</tr>
<tr>
<td>64</td>
<td>NUL</td>
<td>\</td>
<td>64</td>
</tr>
<tr>
<td>65</td>
<td>SOH</td>
<td>a</td>
<td>65</td>
</tr>
<tr>
<td>66</td>
<td>STX</td>
<td>b</td>
<td>66</td>
</tr>
<tr>
<td>67</td>
<td>ETX</td>
<td>c</td>
<td>67</td>
</tr>
<tr>
<td>68</td>
<td>EOT</td>
<td>d</td>
<td>68</td>
</tr>
<tr>
<td>69</td>
<td>ENQ</td>
<td>e</td>
<td>69</td>
</tr>
<tr>
<td>70</td>
<td>ACK</td>
<td>f</td>
<td>70</td>
</tr>
<tr>
<td>71</td>
<td>BEL</td>
<td>g</td>
<td>71</td>
</tr>
<tr>
<td>72</td>
<td>BS</td>
<td>h</td>
<td>72</td>
</tr>
<tr>
<td>73</td>
<td>HT</td>
<td>i</td>
<td>73</td>
</tr>
<tr>
<td>74</td>
<td>LF</td>
<td>j</td>
<td>74</td>
</tr>
<tr>
<td>75</td>
<td>VT</td>
<td>k</td>
<td>75</td>
</tr>
<tr>
<td>76</td>
<td>FF</td>
<td>l</td>
<td>76</td>
</tr>
<tr>
<td>77</td>
<td>CR</td>
<td>m</td>
<td>77</td>
</tr>
<tr>
<td>78</td>
<td>SO</td>
<td>n</td>
<td>78</td>
</tr>
<tr>
<td>79</td>
<td>SI</td>
<td>o</td>
<td>79</td>
</tr>
<tr>
<td>80</td>
<td>DLE</td>
<td>p</td>
<td>80</td>
</tr>
<tr>
<td>81</td>
<td>DC1</td>
<td>q</td>
<td>81</td>
</tr>
<tr>
<td>82</td>
<td>DC2</td>
<td>r</td>
<td>82</td>
</tr>
<tr>
<td>83</td>
<td>DC3</td>
<td>s</td>
<td>83</td>
</tr>
<tr>
<td>84</td>
<td>DC4</td>
<td>t</td>
<td>84</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Code Set A</th>
<th>Code Set B</th>
<th>Code Set C</th>
</tr>
</thead>
<tbody>
<tr>
<td>85</td>
<td>NAK</td>
<td>u</td>
<td>85</td>
</tr>
<tr>
<td>86</td>
<td>SYN</td>
<td>v</td>
<td>86</td>
</tr>
<tr>
<td>87</td>
<td>ETB</td>
<td>w</td>
<td>87</td>
</tr>
<tr>
<td>88</td>
<td>CAN</td>
<td>x</td>
<td>88</td>
</tr>
<tr>
<td>89</td>
<td>EM</td>
<td>y</td>
<td>89</td>
</tr>
<tr>
<td>90</td>
<td>SUB</td>
<td>z</td>
<td>90</td>
</tr>
<tr>
<td>91</td>
<td>ESC</td>
<td>{</td>
<td>91</td>
</tr>
<tr>
<td>92</td>
<td>FS</td>
<td>]</td>
<td>92</td>
</tr>
<tr>
<td>93</td>
<td>GS</td>
<td>}</td>
<td>93</td>
</tr>
<tr>
<td>94</td>
<td>RS</td>
<td>~</td>
<td>94</td>
</tr>
<tr>
<td>95</td>
<td>US</td>
<td>DEL</td>
<td>95</td>
</tr>
<tr>
<td>96</td>
<td>FNC 3</td>
<td>FNC 3</td>
<td>96</td>
</tr>
<tr>
<td>97</td>
<td>FNC 2</td>
<td>FNC 2</td>
<td>97</td>
</tr>
<tr>
<td>98</td>
<td>SHIFT</td>
<td>SHIFT</td>
<td>98</td>
</tr>
<tr>
<td>99</td>
<td>CODE C</td>
<td>CODE C</td>
<td>99</td>
</tr>
<tr>
<td>100</td>
<td>CODE B</td>
<td>FNC 4</td>
<td>CODE B</td>
</tr>
<tr>
<td>101</td>
<td>FNC 4</td>
<td>CODE A</td>
<td>CODE A</td>
</tr>
<tr>
<td>102</td>
<td>FNC 1</td>
<td>FNC 1</td>
<td>FNC 1</td>
</tr>
<tr>
<td>103</td>
<td>Start A</td>
<td>Start A</td>
<td>Start A</td>
</tr>
<tr>
<td>104</td>
<td>Start B</td>
<td>Start B</td>
<td>Start B</td>
</tr>
<tr>
<td>105</td>
<td>Start C</td>
<td>Start C</td>
<td>Start C</td>
</tr>
<tr>
<td>106</td>
<td>Stop</td>
<td>Stop</td>
<td>Stop</td>
</tr>
</tbody>
</table>

(Sheet 3 of 4)
**Objects in Memory**

**Graphic Objects**

The following graphic objects are stored in all new control units and are restored when the memory has been cleared.

Each of these graphics can be edited and deleted in the same way as any other graphic object.

For more information on creating graphics see “Creating a Graphic Object” on page 19.

**Up to 16 Dot High**

These graphics are 16 dots in height or less.

<table>
<thead>
<tr>
<th>Object name: 1</th>
<th>Object name: 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in dots (HxW): 16x19</td>
<td>Size in dots (HxW): 16x22</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object name: 3</th>
<th>Object name: 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in dots (HxW): 16x20</td>
<td>Size in dots (HxW): 16x7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object name: 5</th>
<th>Object name: 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in dots (HxW): 16x17</td>
<td>Size in dots (HxW): 16x16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object name: 7</th>
<th>Object name: 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in dots (HxW): 15x16</td>
<td>Size in dots (HxW): 16x24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object name: 9</th>
<th>Object name: 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in dots (HxW): 16x16</td>
<td>Size in dots (HxW): 16x21</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object name: 11</th>
<th>Object name: 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in dots (HxW): 16x22</td>
<td>Size in dots (HxW): 16x12</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object name: 13</th>
<th>Object name: 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in dots (HxW): 16x111</td>
<td>Size in dots (HxW): 12x15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object name: 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in dots (HxW): 16x23</td>
</tr>
</tbody>
</table>
Up to 32 Dot High

These graphics are between 17 and 32 dots in height.

Object name: 16
Size in dots (HxW): 22x40

Object name: 17
Size in dots (HxW): 32x32

Object name: 18
Size in dots (HxW): 24x106

Object name: 19
Size in dots (HxW): 32x30

Object name: 20
Size in dots (HxW): 32x241

Object name: 21
Size in dots (HxW): 32x33

Object name: 22
Size in dots (HxW): 32x32

Object name: 23
Size in dots (HxW): 32x26

Object name: 24
Size in dots (HxW): 32x32

Object name: 25
Size in dots (HxW): 32x32

Object name: 26
Size in dots (HxW): 32x43

Object name: 27
Size in dots (HxW): 32x44

Object name: 28
Size in dots (HxW): 32x35
Counter Objects

File → Objects → Counter

The following counter objects are stored in all new control units and are restored when the memory has been cleared.

Each of these counters can be edited and deleted in the same way as any other counter object.

For more information on creating counter objects see “Creating a Counter Object” on page 24.

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0. .9</td>
<td>0 to 9</td>
</tr>
<tr>
<td>0. .9(x2)</td>
<td>00 to 99</td>
</tr>
<tr>
<td>0. .9(x3)</td>
<td>000 to 999</td>
</tr>
<tr>
<td>0. .9(x4)</td>
<td>0000 to 9999</td>
</tr>
<tr>
<td>0. .9(x5)</td>
<td>00000 to 9999</td>
</tr>
<tr>
<td>0. .9(x6)</td>
<td>000000 to 99999</td>
</tr>
<tr>
<td>0. .9(x7)</td>
<td>00000000 to 9999999</td>
</tr>
<tr>
<td>0. .9(x8)</td>
<td>000000000 to 999999999</td>
</tr>
<tr>
<td>0. .9(x9)</td>
<td>0000000000 to 99999999999</td>
</tr>
<tr>
<td>9. 0</td>
<td>9 to 0</td>
</tr>
<tr>
<td>9. 0(x2)</td>
<td>99 to 00</td>
</tr>
<tr>
<td>9. 0(x3)</td>
<td>999 to 0000</td>
</tr>
</tbody>
</table>

Clock Objects

File → Objects → Clock

The following Clock objects are stored in all new control units and are restored when the memory has been cleared.

The objects marked with a ▲ symbol are write protected. This means that they can be opened and edited but must be saved with a new name. All other objects can be edited and saved with the same name.

All objects can be deleted.

In each case the date and time is relative to the true time (master clock) setting.

For more information on creating clocks see “Creating a Clock Object” on page 27.

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>YY-MM-DD</td>
<td>Mon 28th Aug 2000 - 14:23</td>
</tr>
<tr>
<td>YY/MM/DD</td>
<td>00:08:28</td>
</tr>
<tr>
<td>YYYY/MM/DD</td>
<td>2000 08 28</td>
</tr>
<tr>
<td>DD-MM-YY</td>
<td>28-08-00</td>
</tr>
<tr>
<td>Object Name</td>
<td>Example</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>DD.MM.YY</td>
<td>28.08.00</td>
</tr>
<tr>
<td>DD/MM/YY</td>
<td>28/08/00</td>
</tr>
<tr>
<td>DDMMYYYY</td>
<td>28 08 2000</td>
</tr>
<tr>
<td>MM-DD-YY</td>
<td>08-28-00</td>
</tr>
<tr>
<td>MM.DD.YY</td>
<td>08.28.00</td>
</tr>
<tr>
<td>MM/DD/YY</td>
<td>08/28/00</td>
</tr>
<tr>
<td>MMDDYYYY</td>
<td>08 28 2000</td>
</tr>
<tr>
<td>hh:mm24H</td>
<td>14:23</td>
</tr>
<tr>
<td>hh:mm12H</td>
<td>02:23PM</td>
</tr>
<tr>
<td>hh.mm</td>
<td>14.23</td>
</tr>
<tr>
<td>Y=0..9</td>
<td>0 (year - last digit)</td>
</tr>
<tr>
<td>00..99</td>
<td>00 (year - last two digits)</td>
</tr>
<tr>
<td>000..999</td>
<td>000 (year - last three digits)</td>
</tr>
<tr>
<td>000009999</td>
<td>2000 (year - all four digits)</td>
</tr>
<tr>
<td>M=01..12</td>
<td>08 (month number)</td>
</tr>
<tr>
<td>D=01..31</td>
<td>28 (day of month number)</td>
</tr>
<tr>
<td>h=00..23</td>
<td>14 (hour in 24hr clock)</td>
</tr>
<tr>
<td>m=00..59</td>
<td>23 (minute)</td>
</tr>
<tr>
<td>WD=1..7</td>
<td>1 (weekday number)</td>
</tr>
<tr>
<td>W=01..52</td>
<td>35 (week number)</td>
</tr>
<tr>
<td>001..365</td>
<td>241 (day of year number - Julian date)</td>
</tr>
<tr>
<td>Mon..Sun</td>
<td>Mon (day name)</td>
</tr>
<tr>
<td>Jan..Dec</td>
<td>Aug (month name)</td>
</tr>
<tr>
<td>▲+1 DAYa</td>
<td>One day after NORMAL</td>
</tr>
<tr>
<td>▲SUMMERa</td>
<td>Full format date following daylight saving time rules</td>
</tr>
<tr>
<td>▲DATEa</td>
<td>Date in format dd-mm-yy</td>
</tr>
<tr>
<td>▲TIMEa</td>
<td>Time in format hh:mm</td>
</tr>
</tbody>
</table>

**Timecode Objects**

The following timecode objects are stored in all new control units and are restored when the memory has been cleared.

These objects are write protected. This means that they can be opened and edited but must be saved with a new name.

All timecode objects can be deleted.

For more information on creating timecode objects see “Creating a Timecode Object” on page 28.

(a) Name consists of 8 characters including spaces at end. These names appear in the selected language.

<table>
<thead>
<tr>
<th>Object Namea</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+, -</td>
<td>The characters “+” (plus), and “-” (minus) are displayed for a period of one minute alternately. Normal time is used.</td>
</tr>
<tr>
<td>A - Z</td>
<td>Each letter of the alphabet is shown for a period of one hour. Normal time is used.</td>
</tr>
</tbody>
</table>

(a) Name consists of 4 characters including space character at the end.
Font Examples

The following shows example screen dumps of all fonts supplied with your printer. They have been included to give the user basic information on each font's appearance. The actual appearance of each font, when printed, is dependant on many factors, such as print target material, dot size and the print height reduction setting.

- All fonts shown here are included with your printer although the fonts which are available when creating a Message depends on which print heads the printer has been set up for.

The fonts are divided up into two groups according to the following:

**Monotype** - Fonts with characters of equal width.

**Proportional** - Fonts where different characters have different widths depending on their shapes.

### Monotype Fonts

All characters in monotype fonts have equal widths. This has the advantage that the same number of characters will always take up the same amount of space in the message. Note also that the proportional font 32-Plain has monotype digits.

- **5x5** - Each character is 5 dots high and 5 dots wide. A single spacing dot is added between characters.

- **7x7** - Each character is 7 dots high and 7 dots wide. A single spacing dot is added between characters.

- **9x7** - Each character is 9 dots high and 7 dots wide. A single spacing dot is added between characters.

- **10x7** - Each character is 10 dots high and 7 dots wide. A single spacing dot is added between characters.

- **14x10** - Each character is 14 dots high and 10 dots wide. A single spacing dot is added between characters.

### Proportional Fonts

The fonts used in this document are made up of characters with different widths depending on each character shape. The letter “i”, for example, takes up less space than the letter “w”. The proportional fonts included in your printer work in the same way, avoiding unnecessary gaps between characters.

This has the advantage that characters fit better together making texts more legible (easier to read).

On the other hand it is difficult to work out the length of a text, especially if it includes a variable such as a day or month name.

Note that the 32-Plain font has monotype digits.
7-Flex - 7 dot high characters.

10-Menu - 10 dot high characters.

16-Nice - 16 dot high characters.

32-Plain - 32 dot high characters. This font includes monotype digits.

32-Serif - 32 dot high characters.
# Index

## Numerics
- 24H and 12H clocks 27

## A
- AllNodes 45

## B
- Barcodes
  - Creating Favourites to 12
  - Creating, Editing, Storing 22
  - Deleting 29
  - Entering special characters 23
  - Importing data 24
  - Information 68
  - Interpretation 23
  - Troubleshooting 63
- By, in counter 24

## C
- Calendar 59
- Cause, in counter 25
- Clearing a message 40, 42, 43, 46
- Counters
  - Counter updates counter 26
  - Creating Favourites to 12
  - Creating, Editing, Storing 24
  - Deleting 29
  - Down-counter 24
  - Examples 25
  - Invisible 26
  - Objects in memory 74
  - Rules 25
  - Skipping letters I and O 24
  - Up-counter 24
- Dates 59
- Date 59
- See Clocks
- Day name 59
- Default
  - Global settings 57
  - Message settings 53
- Defining, in Timecodes 28

## D
- Combining limit functions 59
- Constant character separation 36
- Contrast in keyboard display 47
- Control panel functions
  - Clearing a message 42, 43
  - Confirming errors 67
  - Flushing the print head 42, 43
  - Printing a message 42
  - Selecting ink/cleaner 42, 43
- Control unit panel functions
  - Printing a message 42
- Copying data from another control unit 44
- Counters
  - Counter updates counter 26
  - Creating Favourites to 12
  - Creating, Editing, Storing 24
  - Deleting 29
  - Down-counter 24
  - Examples 25
  - Invisible 26
  - Objects in memory 74
  - Rules 25
  - Skipping letters I and O 24
  - Up-counter 24

## E
- Editing messages 34
- Erasing data
  - See Deleting data
- Error codes and messages 64
- Exercises 13

## F
- Favourites 12
  - Viewing 12
- Field Attr 34
- Field attributes 33
  - Dark, Light, Inverse 36
  - Setting for message 36
- Fields
  - Positioning in message 31
  - Finding files 12

## Deleting data
- Favourites 29
- Message fields 36
- Messages 29
- Objects 29
- Direction of print
  - Setting 51
- Display 8
- Dot size
  - Changing in message 37
  - Default 53
- Drawing
  - Changing in message 37
  - Default 53
  - Dark, Light, Inverse 36
  - Setting for message 36
  - Examples 25
  - Invisible 26
  - Objects in memory 74
  - Rules 25
  - Skipping letters I and O 24
  - Up-counter 24

## Finding files
- 12

---

**JET·A·MARK S.C.I. F.I. 3400, DOD·8400 & R44** 79
INDEX

Flush times 61
Flushing the print head 42, 43, 61
Format 27
From, in counter 24

G
Global
Message settings 57
Global settings
Combining limit functions 59
Date 59
Day name 59
Limiting printout 57
Mark gap 58
Max mark 58
Max trig 58
Month name 59
Terminate 57
Time 59

Graphics
Clearing, Moving 21
Creating Favourites to 12
Deleting 29
Saving 22
Selecting area 21

H
Head, in network 44
Height 49
Help 13
Hotkeys 12

I
Import
Data to barcode 24
Importing objects into a message 32
Objects 19
Ink supply units 8
Interpretation, in barcode 23

K
Keyboard 47
Audible keys 47
Display 8
Display contrast 47
Menu 9
Menu path 8
Overview 8
Screen saver 47
Setting up 47

L
Learning 13
Length
Of messages 40
Lessons 13
Limiting printout 57
Line 33
LoU in control unit display 63

M
Margin 38, 53
Mark 25
Mark gap 58
Master clock 59
Master functions 45
Max mark 58
Max trig 58
Measurement system 47
Menu 9
Menu overview 1
Message default
Dot size 53
Margin 53
Spacing 54
Target length 54
Messages
Creating 30
Creating Favourites to 12
Deleting 29
Editing 34
Length 40
Positioning on print target 38
Printing 41
Setting up 34
Shared by print heads 30
Missing dots 57, 62
Month name 59
Multi-message text 19

N
National settings
Measurement system 47
Network functions
Copying data from another control unit 44
Operating one control unit from another 44
Next, in counter 24
INDEX

O

Objects
  Creating 19
  Creating Favourites to 12
Deleting 29
  Importing to message 32
  In memory 72
Overlapping dots
  See Field attributes
Overview
  Keyboard 8

P

Path in keyboard display 8
Period, in counter 24
Print Attr 37
Print attributes
  Changing 37
  Dot size 37
  Margin 38
  Spacing 38, 39
Print direction
  setting 51
Print head
  Flushing 42, 43
  Printing with more than one 30
Print speed
  See Spacing
Printing a message 34, 42
Printing a message at all heads 45
Printout
  Height 49
  Positioning 38
  Stopping 40, 42, 43, 46
Program version
  Control panel 41, 42

R

Rectangle 33
Reduced print height 54
Removing data
  See Deleting data
Repeat print
  See Mark gap

S

Saving a message 34
Screen 8
Searching for files 12
Selecting a message for printout
  See Printing a message
Service
  Time for 68
Shift code
  See Timecodes
Shortcuts 12
Show all, in clock 27
Show in Timecodes 28
Single-message line
  Entering in message 33
  Single-message text
  Entering in message 33
Slant percentage 38, 54
Slanting printout 50
Software version number 64
Spacing 54
  See also Print attributes
Special characters in barcodes 23
Stopping all printouts 45
Stopping printout 40, 42, 43, 46
Strong first dots in printout 57
Symbols, in this guide 3
System overview 5

T

Target L. 39
Target length 54
Terminate 57
Test-printing a message 34
Texts
  Creating Favourites to 12
  Creating, Editing, Storing 19
  Deleting 29
Tilting print head
  See Reduced print height
Time 59
  See also Clocks
Time for service 68
Timecodes
  Creating Favourites to 12
  Creating, Editing, Storing 28
  Defining 28
  Deleting 29
  Editing 28
  In memory 75
  Selecting a clock for 28
  Show 28
  View Now 28
To, in counter 24
Trig, in counter 25
Troubleshooting 62
True-time
  See Master clock
Tutorial 13

U-Z

Units, metric or imperial 47
Variable character separation 36
Version number, software 64
View Now, in Timecodes 28
Weak first dots in printout 57
MiTek Inker: Matthews 5100, 5400, and 8400

001070
Rev. E